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Executive Summary   
Wetlands provide critical ecosystem services across a range of environmental gradients and are 
at heightened risk of degradation from natural and anthropogenic drivers and continued 
development, especially in coastal regions. There is a growing need for high resolution, spatially 
and temporally, accurate habitat identification, and precise delineation of wetlands across a 
variety of stakeholder groups, including wetlands loss mitigation programs and especially the 
North Carolina Department of Transportation (NCDOT) Environmental Analysis Unit. 
Traditional wetland delineations are costly, time-intensive and can physically damage the 
systems that are being surveyed, while aerial surveys are relatively fast and unobtrusive. With 
funding from NCDOT, we acquired a DJI Matrice 600 Pro UAS outfitted with a Quanergy M8 
LiDAR sensor in March 2020 and have conducted fieldwork at 9 sites in 4 coastal counties in 
NC to test the performance of LiDAR-derived data in wetland classification. We tested the 
comparative accuracies of a wetland prediction model fitted with UAS and airborne LiDAR 
terrain and topographic derivatives along with UAS-collected multispectral data at using 
machine learning approaches. When mounted on low-flying UASs, LiDAR sensors can measure 
elevation data even underneath dense forest canopy cover characteristic of much of the Atlantic 
coastal plain forested wetlands. We demonstrated that the UAS hyperspatial LiDAR derivatives 
outperformed the airborne statewide LiDAR data in deriving high resolution and high 
classification accuracy rates, especially when trained with field-collected habitat data and 
supported by UAS-collected multispectral data. The hyperspatial resolution of LiDAR-derived 
topography models as well as vertical vegetation structure data (such as canopy height models) 
can fill wetland mapping needs and increase map accuracy and efficiency of wetland detection 
and prediction of sensitive wetland ecosystems. The main research products generated from this 
project include a ready-to-fly and operate UAS LiDAR system that has been thoroughly tested 
and comes with step-by-step operation instructions, fixed-wing UAS multispectral data and 
derived vegetation indices, in situ ground control point (GCP) and ground reference point (GRP) 
point data, metadata and data dictionaries for all raw and derived datasets, and final machine 
learning classification products and scripts that can be compared to existing DOT datasets and 
other potential future delineations.  

Given that the goal of this project was to provide NC DOT with detailed approaches to using 
UAS technologies to derive maps of environmental features (not just wetlands), we worked 
synergistically with NC DOT so that the products are directly applicable to assisting the 
Environmental Analysis Unit at DOT in the implementation of project planning and 
development. Therefore, at all stages of this project, our team has done our best to include one or 
more NC DOT staff in providing guidance, meet at our regularly scheduled meetings, work in 
the field when available so that the full UAS flight process and collection of ancillary data were 
thoroughly understood, review GIS and data products, and participate in technology transfer 
through a two-day workshop completed before the project ended. The UNCW team feels that we 
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have been successful if the products from our case studies will have been used in NC DOT 
project planning.  

Finally, in order to ensure adequate technology transfer, not only did we hold a two-day training 
workshop, but we made every effort for NCDOT staff to be comfortable using the UAV 
equipment as well as processing data to produce cartographic products and GIS data that can be 
directly imported into NC DOT enterprise databases during the entire duration of the project, in 
addition to bi-weekly progress report meetings. At the completion of this project, we are truly 
grateful for the opportunity to work on this research project and we strongly believe that the 
correct use of UAS technology can save NC DOT money, long-term, by implementing a strategy 
that reduces the number of days that surveyors are currently out in the field. However, as our 
discussion of limitations and modeling section underscore, this technology is not a replacement 
for surveying, it is a means of utilizing aerial approaches to highlight and map potentially 
sensitive resources that can then be surveyed and incorporated into the project planning and 
workflow processes by NCDOT teams across multiple divisions. 
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Introduction 
The purpose for research project RP2020-04 was to provide case studies that demonstrate the 
data collecting workflow (mission planning, fight protocols, ancillary data collection such as 
GCPs and species-specific spectral curves), image processing techniques and object-based 
classification algorithms that can provide useful information that can be both directly and 
indirectly implemented in the Wetland Prediction Model (WPM) tool. Prior to the start of 
RP2020-04, in PI Pricope’s Socio-Environmental Analysis Lab at UNCW, we had been 
conducting extensive UAS-based research and development centered on: establishing field data 
collection; sampling and calibration and validation protocols for effective UAS data collection 
and processing using three different types of drone sensors; implementing processing workflows 
to create validated, ortho-photogrammetrically and planimetrically correct UAS-derived products 
(orthomosaics, reflectance maps, indices, 3D digital surface and digital terrain models, 3D 
models and visualizations, derived metrics such as canopy texture, heights, sizes); and applying 
and developing geospatial analysis and UAS to satellite imagery fusion techniques, including 
machine learning vegetation classification algorithms.  

In 2018, under RNS-2020-031, the NC DOT requested proposals that guided the implementation 
of UAS platforms, sensors and imagery into current workflows and the WPM and met the 
following criteria: review current UAS technologies, are posed to make recommendations for 
potential acquisition of UAS platforms and sensors by the NC DOT, establish processes and 
repeatable and transferable protocols for flight planning and create reliable, automated and fast 
workflows for post processing and algorithms/models for feature classification. Because UASs 
were seen as a viable solution for identifying important environmental features for planning and 
project development purposes by improving efficiencies in data capturing and reducing 
mobilization times and costs, we leveraged our expertise and provided case studies, metrics, 
models and recommendations to support expressed NC DOT needs, which we detail below.  

Effective UAS platform incorporation into WPMs does not only benefit NC DOT compliance by 
providing them with the ability to quickly capture the most up-to-date UAS data possible, but 
results from this project also provides guidance on effective workflow integration including 
machine learning wetland classification techniques. Our overarching goal for this project was 
to provide geospatial methods and data that can be used for project planning and 
implementation with the NC DOT wetland prediction models. We provided this guidance 
through our research project by focusing on three main components:  

1. Field and data collection methods: wetland sampling strategy, Real Time Kinematic 
(RTK) Global Positioning System (GPS) for collecting Ground Control Points (GCPs) 
and Ground Reference Points (GRPs), and field spectroradiometer data to derive species 
spectral curves. 

2. UAS imagery, LiDAR and in situ data collection: flight and mission planning for 
various sensors, in-field radiometric calibration and GCPs, instrumentation uses in a 
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variety of coastal wetlands from freshwater to saltwater, photogrammetric image 
processing workflows to derive planimetric products (RGB, LiDAR, multispectral and 
thermal). 

3. UAS classification techniques for geospatial modeling: LiDAR data processing, use of 
canopy height, LiDAR-derived topographic metrics, comparison with airborne imagery 
and statewide LiDAR data to improve classification of sensitive habitats, including but 
not limited to wetlands and make recommendations.  

Traditional wetlands delineation methods are not only challenging to complete (especially in 
areas that are partially or completely inundated or densely vegetated), but can physically degrade 
the wetland system being surveyed, placing ecosystems that are already both structurally and 
functionally fragile at further risk (Jeziorska, 2019). To remedy the inefficiencies in both 
traditional wetlands delineations and nationwide datasets, many researchers now rely on 
unmanned aerial systems (UASs) as a remote sensing method of choice for wetlands mapping as 
the miniaturization of both platforms and sensors, increased production, and decreased costs 
have made them more attainable (Jeziorska, 2019; Kim et al., 2020; Pricope et al., 2020). The 
utility of UAS sensor technology is further enabled by advances in analytical methods including 
artificial intelligence and machine learning. In the context of higher population pressures on 
coastal environments and shifting wetland extents and composition we collaborated with the NC 
DOT Environmental Analysis Unit to design an effective and automated classification 
methodology that allows us to leverage freely available aerial imagery and this project-collected 
UAS-derived data (in situ reference data, UAS LiDAR, and multispectral imagery) collected at 
sample locations of interest to improve NC DOT’s ability to identify environmental features 
beyond wetlands for early planning purposes for road planning and project delivery. 

The following research products have resulted from the completion of our three main objectives, 
divided into five research tasks (further detailed in the report body): 

1. Review of current technologies based on our research, data collection, processing and 
implementation workflow and final reporting based on the most current, state-of-the-art 
applications and a recommendation for a powerful and competitive UAS-borne LiDAR 
sensor acquisition based on our field experimentation and reporting in the peer-reviewed 
journal Sensors; 

2. Complete, repeatable and easily-implementable protocols for flight planning, including a 
design guide and flight planning and implementation protocols for multispectral and 
LiDAR collection and processing; 

3. Complete, repeatable and semi-automated data processing and post processing 
workflows, including LiDAR step-by-step detailed specifications, including 
incorporation of in situ data collection using Trimble RTK ground control point (GCP) 
collection, data transfer and processing in Trimble Business Center;  
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4. Algorithms and models for feature extraction and classification based on statistical 
experimentation with several techniques for wetlands classification, having finally settled 
on pixel-based Random Forest classification that can be computed either in R or Esri’s 
ArcGIS; 

5. Training workshop with manuals, data collection and data processing demonstrations 
conducted on UNCW’s campus on November 16-17th 2022.  

An important secondary and technical objective that emerged post data collection was to 
quantify metrics derived from UAS-derived light detection and ranging (LiDAR) point clouds in 
wetlands located along a palustrine to estuarine gradient across nine data collection sites and 
compared the performance of those metrics in predicting the presence of wetlands. We utilized 
LiDAR to overcome the challenges of producing accurate surface models from imagery in even 
sparsely vegetated areas (Rotnicka et al., 2020). We utilized an existing wetlands delineation 
produced using traditional survey methods from the North Carolina Department of 
Transportation (NCDOT) and in situ ground reference point (GRPs) data as validation in this 
project.  

We addressed two primary research questions:  

1) Does the inclusion of UAS-derived LiDAR topographic derivatives and canopy height 
information along with UAS-collected multispectral data accurately classify wetlands 
using a Random Forest classification model? and  

2) What are the most important variables for predicting wetland presence?  

This report is organized into several sections, following the NCDOT guidance document for final 
reporting. Specifically, we begin by presenting a literature review that discusses the importance 
of wetland ecosystems for Coastal Plain human-environment functioning, the need for updated 
wetland maps and classifications, the emergence of UAS technologies as a mechanism to obtain 
accessible and on-demand imagery and data, and the emergence of machine learning 
classification approaches capable of handling large volumes of data such as those generated from 
UAS data collections. We then proceed to the report body which is organized according to our 
main project objectives and subdivided into the five major tasks undertaken in this project. We 
then present the main findings and conclusions organized by each site and discuss some of the 
challenges, limitations and future directions we envision. Lastly, we provide a set of summative 
recommendations and our implementation and technology transfer accomplishments. After the 
references cited section, we have included two appendices: Appendix A contains the R modeling 
steps for deriving the final wetland classification model, and Appendix B contains the final 
instruction manual for the project. Student Theses and Final Projects referenced in this report are 
not included due to length considerations, but can be provided upon request by NCDOT 
personnel, but for their use only; not to be further distributed until they are officially published or 
released from embargo from UNCW. 
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Literature Review  
Wetlands are transitional zones between terrestrial and aquatic ecosystems which experience 
seasonal or permanent above surface water (Dillabaugh & King, 2008). They are dynamic 
systems that are subject to an array of changes through river erosion and deposition, vegetation 
growth, and human impacts (Walker, 2011). Wetlands are considered one of the most productive 
ecosystems and act as critical habitats for a variety of plants and wildlife (Klemas, 2013b; 
Durgan, Zhang, Duecaster et al, 2020). They play crucial roles as carbon sinks due to their 
extreme ability to sequester carbon (Klemas, 2013b). Salt marshes are some of the most 
productive ecosystems, with productivity reaching as high as 3000 g C/ m2/y, exceeding the 
productivity of some agricultural crops (Campbell, et al., 2000). Not only are they excellent 
carbon sinks, but they also provide protection from storm runoff, improve water quality, filter 
agricultural and industrial waste, recharge groundwater stores, and enhance biodiversity 
(Klemas, 2013b). Furthermore, wetlands provide aesthetic, spiritual, and recreational benefits 
(Luo et al, 2015). Next to tropical rainforests, they are considered one of the most economically 
important ecosystems, being valued at US $10,000 per hectare (Kirwan & Megonigal, 2013; Luo, 
et al., 2015).  Despite being critical ecosystems, wetlands are under increasing threat by 
anthropogenic stressors such as dredge and fill operations, eutrophication, fragmentation, 
constructed modifications, urban development, and sea level rise (Klemas, 2013b; Kirwan & 
Megonigal 2013). Approximately 25 – 50% of the world’s coastal wetlands have been converted 
to agricultural or aquaculture uses in the twentieth century with predictions that another 20 – 
45% will be lost to sea level rise during this current century (Kirwan & Megonigal, 2013).  

Assessing the future ability of wetlands to continue providing ecosystem services requires 
continuous mapping and this is challenging because of the detailed vertical and horizontal scale 
of these areas (Kalacska, et al., 2017). Wetlands by nature are periodically flooded, causing 
access to be limited. This periodic flooding makes conventional surveying more labor intensive 
and time consuming than it already is. Furthermore, conventional surveying would be extremely 
harmful to the ecosystem because of the heavy foot traffic that it causes. Forested coastal 
wetlands are also extremely difficult to map because of their dense canopies (Pricope, et al., 
2020). Coastal wetlands pose an even greater challenge due to the constant changing of the tides. 
During the 1970s and 80s when the National Wetland Inventory (NWI) was first introduced, 
wetlands were mostly mapped using satellites at relatively coarse spatial resolutions and large 
temporal revisits (Walker, 2011). This was a significant first step toward creating a system where 
wetland maps would be stored. However, much of the data that is available today is not as useful 
as it once was because that data is the original data from the 1980s (Walker, 2011). This data is 
not useful because there are maps in the inventory that show wetlands that are no longer existent 
and omit existing wetlands that were missed. North Carolina’s coastal wetlands were last 
mapped between 2006 and 2015.  

The wetlands on the North Carolina and South Carolina border were last mapped between 1986 
and 1995 while the rest of the state’s wetlands have not been mapped since the 1980’s. Also, the 
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limited spatial and temporal resolutions of the satellite imagery make them difficult to classify 
and define (Pricope, et al., 2020). This has caused the United States to have a very limited 
database of these wetlands. Accurate and up-to-date Coastal Plain wetland delineation and 
classification maps and models can contribute to protecting and improving wetland resilience. 
However, Coastal Plain wetland identification and delineation are labor-intensive, time-
consuming, and costly. Traditional wetland delineation and classification are conducted by 
ground-truthing in the field and these delineations are considered to be the most reliable. Field 
surveys require specialized knowledge of wetland ecology based on hydric soil and aquatic and 
emergent vegetation detailed identification. Field surveying in Coastal Plain wetlands is made 
even more complicated by topography. Most coastal wetlands are dominated by thick forest 
cover and/or muddy ground unlike grass or non-forested wetlands. When areas of interest have 
partially or completely inundated ground cover and thick or impenetrable vegetation cover, even 
locations that are not very remote become difficult to access (Jeziorska, 2019; Pricope et al., 
2020). Also, the ecosystems can get damaged in the process of fieldwork. The difficulties of 
wetland surveying are not only limited to technical complexities but are further complicated by 
financial and duration considerations. The estimated cost of field-based wetland delineation in 
east North Carolina ranges from $ 120 – 180/ per acre and can take several weeks to complete a 
2000–3000-acre delineation, according to representatives from North Carlina Department of 
Transportation (NC DoT) (personal communication, September 1st, 2021). Coastal Plain 
wetlands make up 76.3 % (3,100,703 acres) of wetland areas in North Carolina (Gale, 2021a), 
and the most recent wetland cover dataset for this area was completed as part of the National 
Wetlands Inventory (NWI) between 2001-2010 (Figure 1), which wetland cover might have been 
altered by now. The extensive spatial scale of wetlands in NC will translate to increase cost and 
manpower conducting these ground surveys, which makes it very difficult to maintain regularly 
updated wetland maps updated regularly. As such, wetland delineations and classifications based 
on remotely sensed data are common in filling the gaps between field delineations. 
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Figure 1. NWI source image year map in North Carolina, USA. 
There are various wetland systems developed at state, regional, and national levels (LePage, 
2011; "Wetlands: Integrating Multidisciplinary Concepts," 2011), and the wetland classes in 
these classification schemas are developed based on the Classification of Wetlands and 
Deepwater Habitats of the United States, made by Cowardin (Cowardin et al., 1979) and further 
developed as a second edition in 2013 (Committee, 2013). The Cowardin system was designed to 
inventory the wetlands and deep-water habitats of the United States. Although deep-water is not 
considered a wetland ecologically, this classification includes deep-water habitats characterized 
as “permanently flooded lands lying below the deep-water boundary of wetlands” to have a 
broader acceptance. The Cowardin hierarchy system is organized as follows: system; subsystem; 
class; dominance type; and modifiers, and the five main systems are marine, estuarine, riverine, 
lacustrine, and palustrine (Table 1). The class level system is used to categorize wetland types in 
this research, however, any areas classified as flooded permanently in the system such as 
unconsolidated bottom or shore are classified as non-wetland or water in this study. 
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Table 1. Description of five wetland systems according to the Cowardin wetland classification 
system (Cowardin et al., 1979) and also the systems used and referenced in this report 
classification section. 

Wetland 
System Description 

Marine The Marine System consists of the open ocean overlying the continental shelf and its 
associated high-energy coastline. 
The Marine System consists of the open ocean overlying the continental shelf and its 
associated high-energy coastline. Marine habitats are exposed to 
the waves and currents of the open ocean and the Water Regimes are determined 
primarily by the ebb and flow of oceanic tides.  

Estuarine The Estuarine System consists of deep-water tidal habitats and adjacent tidal wetlands 
that are usually semi-enclosed by land but have open, partly obstructed, or sporadic 
access to the open ocean, and in which ocean water is at least occasionally diluted by 
freshwater runoff from the land.  

Riverine The Riverine System includes all wetlands and deep-water habitats contained within a 
channel, with two exceptions: (1) wetlands dominated by trees, shrubs, persistent 
emergents, emergent mosses, or lichens, and (2) habitats with water containing ocean-
derived salts of 0.5 ppt or greater.  

Palustrine The Palustrine System includes all nontidal wetlands dominated by trees, shrubs, 
persistent emergents, emergent mosses, or lichens. It also includes wetlands lacking 
such vegetation, but with all of the following four characteristics: (1) area less than 8 ha 
(20 acres); (2) active wave-formed or bedrock shoreline features lacking; (3) water 
depth in the deepest part of basin less than 2.5 m (8.2ft) at low water; and (4) salinity 
due to ocean-derived salts less than 0.5 ppt 

Lacustrine The Lacustrine System includes wetlands and deep-water habitats with all of the 
following characteristics: (1) situated in a topographic depression or a dammed river 
channel; (2) lacking trees, shrubs, persistent emergents, emergent mosses, or lichens 
with greater than 30% areal coverage; and (3) total area exceeds 8 ha (20 acres). 

 

Historically, remote sensing technologies have been used as a tool to tackle the issues associated 
with traditional wetland surveys since the advance of aerial photography in the late 18th century 
(Guo et al., 2017). Remotely sensed data can be used for interpretation and verification, and 
more often for image classification into distinct vegetation or land cover classes. Image 
classification refers to a categorization of pixels (reflectance values) in a remotely sensed dataset 
in order to differentiate among various Earth feature classes such as forest, bare ground, and 
water. Remote sensing imagery, whether from satellite, airborne sources, or, more recently, 
unmanned aerial systems (UAS), enables wetland researchers to access data for areas that are 
physically inaccessible to surveyors and takes significantly less time to collect Earth surface data 
than field surveys with minimal disturbance to the areas. 

Various sensors are used for remote sensing, ranging from optical, visible spectrum data 
collected by RGB cameras to Light Detection and Ranging (LiDAR), and multispectral (MS) 
data. Satellite and airborne platforms have been collecting imagery with various spatial, spectral, 
and temporal resolutions over the past few decades, starting with earth-observing satellites in the 
1970s. Satellite and airborne platforms can obtain data for large areas at once, but the common 
trade-offs are the high cost of imagery access, fixed revisit periods, and large and mixed pixels 
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that make it difficult to delineate small or medium-sized wetlands or determine wetland cover 
composition. Although some recent commercial orbital satellites collect imagery with a very 
high spatial resolution (less than 1 square meter), the imagery costs remain prohibitive for non-
commercial purposes. 

Figure 2. Comparison figure of the three remote sensing platforms in terms of flight altitude and 
coverage. 

Today, wetland mapping is done using digital imagery from aerial remote sensing, such as 
unmanned aerial systems (UAS) or unmanned aerial vehicles (UAV), in addition to satellite and 
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airborne-based collections (Table 2). Mapping, delineation, and classification is automated or 
semi-automated whenever possible. As UAS technology advances, we continue to look for new 
and improved ways to produce high accuracy outputs. The introduction and relatively 
widespread adoption of Light Detection and Ranging (LiDAR) technology and the Structure 
from Motion – Multi View Stereo (SfM – MVS) algorithm based on UAS data have extended 
our ability to detect and identify wetlands remotely.  
 

Table 2. Comparison between the spatial, temporal and spectral resolution of satellite vs. 
Airborne vs. UAS collections 

 Satellite  Airborne  UAS  

Field of View 10 – 50 km 2 -5 km 50 – 500 m 

Spatial Resolution 1 - 30 m 30 cm -1 m 0.5 – 10 cm 

Temporal Resolution 5 - 16 Days Yearly  On demand 

Cost for Data 
Acquisition 

Very high for high 
resolution imagery 

High depending on spatial 
coverage  

Low or relatively low 

Data Types Multispectral Aerial Photography, 
LiDAR) 

Multispectral and LiDAR 

 
The two main remote sensing sensor types associated with UAS-based wetland analysis, 
specifically for mapping of wetlands, are multispectral and LiDAR systems. Multispectral 
sensors collect images within a specific wavelength range across the electromagnetic spectrum. 
Multispectral measurements have been proven to be highly effective for vegetation classification 
and evaluating soil moisture content (de Boisvilliers & Selve, 2019). Multispectral imagery is 
widely used because it is one of the most affordable and available remote sensing systems. While 
multispectral sensors collect Earth surface reflectance data, an active LiDAR sensor collects a 
point cloud with elevation and intensity of returns data. A LiDAR sensor emits light energy and 
receives the returning pulse to calculate the elevation of any objects in the path of the energy 
beam. The velocity of the light pulse is known; therefore, the topography can be calculated from 
the time lapse when the pulse was transmitted to when it was reflected (Klemas, 2013a). Over 
the past decade, many studies have used LiDAR to obtain information about ground elevation 
and vegetation structure because LiDAR can quickly collect dense elevation data over large 
areas. LiDAR has been successfully used as an aid for mapping both vegetation and ground 
elevation in forest ecosystems, such as wetlands (Ritchie, 1996; Lefsky, et al., 2002).  LiDAR 
data can produce high-quality digital terrain models (DTMs) compared to the DEMs that can 
result from optical imaging sensors or even synthetic aperture radar data. That is because the 
laser pulse can penetrate through canopy gaps and can collect the ground-level elevation data 
even underneath the forested area. DEMs are often used to create various topographic 
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derivatives, including aspect, slope, and curvature. Especially when their spatial resolution is 
high, both DEMs and their topographic derivatives have been shown to be useful for evaluating 
hydrologic features in regions of low topography, making them ideal for wetland delineation 
(Hogg & Todd, 2007; Millard & Richardson, 2013).  

The uncertainty in derived elevation products can vary between areas, which is especially 
problematic in wetlands ecosystems containing dense vegetation. Determining the spatial 
patterns in vegetation structure and distribution is crucial in delineating wetlands due to their 
constant change in subtle variations (Fernandez-Nunez, et al., 2017). Wetland vegetation poses 
further challenges due to their low spectral contrast between species, and their small-scale 
patterns and distributions (Millard, et al., 2013). Accurate field measurements are crucial to 
obtain the most accurate vegetation structural parameters (height, vegetation cover, leaf area 
index, and biomass), while understanding these vegetation structural parameters is important for 
the accuracy of derived model outputs (Luo, et al., 2015). These derived model outputs include a 
digital surface model (DSM) representing the ground elevation plus vegetation, a digital 
elevation model (DEM) representing the area without vegetation, and/or a digital terrain model 
(DTM) representing only the bare ground. Inaccurately determining the elevation and 
distribution of wetlands plant species could cause unnecessary errors in these outputs, which then 
could lead to inaccurate analysis. 

Multispectral data collection, especially when conducted from a UAS can further add important 
information to help improve wetlands classification. Structure from Motion refers to the creation 
of a 3D product of an area by using a series of 2D images (Kholil, et al., 2021). SfM- MVS 
creates image derived point clouds and is integrated with a photogrammetric algorithm called 
Multi – View Stereo (MVS) that increases point cloud density which can be used to create 
accurate elevation models (Smith, et al., 2016). Point clouds represent 3D shapes or features 
where each point has its own set of X, Y and Z coordinates. The SfM – MVS algorithm is related 
to the geometry of structures within a scene from multiple viewpoints on a moving camera, such 
as a UAV. SfM – MVS is much newer than LiDAR and has been adopted by commercial and 
open-source software packages designed for non – experts (Berra & Peppa, 2020). 

Research shows that the accuracy of land cover classifications improves when combining 
multispectral and LiDAR data and derivatives, in addition to any filed collected data (Rapinel et 
al., 2015). Fusing or combining multispectral and LiDAR data works because each sensor data 
can complement each other. While multispectral data can provide spectral reflectance 
information to classify vegetation, soil, and artificial objects in an image, LiDAR data can offer 
proxies for hydrology by being able of measuring and detecting subtle changes in elevation or 
vertical vegetation structural information. However, to the authors’ knowledge, the fusion of 
hyperspatial LiDAR and multispectral data collected via UAS platforms for wetland 
classification remained unexplored. Hyperspatial resolution is relatively new and enables more 
precise landscape features to be depicted. Given the low-lying, minimal topography variations of 
coastal wetlands, typical workflows, and datasets to obtain hydrologic indices and drainage 
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patterns tend to not work as effectively as they would in areas of more defined terrain. In this 
paper, building towards the goal of enhanced wetland delineation and classification, we test 
several wetland prediction models made by image classification and show the relative 
classification accuracies of two variable-spatial resolution LiDAR sensors mounted on UAS and 
aircraft platforms in addition to UAS multispectral data (UAS hyperspatial LiDAR + UAS 
multispectral vs. aircraft non-hyperspatial LiDAR + UAS multispectral). 

Because of the detailed and large nature of UAS-collected LiDAR and multispectral datasets 
commonly used to map wetlands, machine learning (ML) algorithms have emerged as a 
reasonable approach. Machine learning is defined as computational methods using experiences 
and examples to improve model performance to make accurate predictions (Mohri et al., 2018), 
and ML algorithms are trained through either supervised or unsupervised learning. The main 
distinction between the two approaches is whether the dataset is labeled or not. A supervised 
learning algorithm uses labeled input and output data while an unsupervised learning algorithm 
does not. Many studies use supervised ML algorithms to classify wetlands because the input 
dataset is already labeled (Millard & Richardson, 2013; O'Neil et al., 2018; Tian et al., 2016).  

One frequently used ML algorithm for land and vegetation classification is Random Forests (RF) 
because it produces high classification accuracy, descriptive variable importance, and it is 
relatively simple to interpret. RF is a supervised classification algorithm that uses an ensemble of 
decision trees and training data with the bagging method and was developed by Bierman in 2001 
(Breiman, 2001). The advantages of RF include the high output classification accuracy, the 
ability to handle both continuous, categorical data and big/high-dimensional data, and, as such, 
RF algorithms can contribute to improved wetland delineations and classifications (Tian et al., 
2016). Therefore, we built an RF model to classify Coastal Plain wetlands using remote sensing 
data. The process of RF starts with sampling bootstrapped datasets from a training dataset. A 
bootstrap resampling technique chooses a random subset from the training dataset with 
replacement. That means that each time you select a subset of data, you can select the same data 
more than once. Each decision tree is trained and created independently from the bootstrapped 
samples in parallel with all other decision trees, which together is called a Random Forest model. 
Finally, a majority of the predictions are taken to compute the final classification output. 
Random forest models can generate a variable importance plot which indicate how much each 
variable is contributing to the classification model, and they are often calculated by the mean 
decrease accuracy metric (Wei et al., 2015). The Mean Decrease Accuracy plot expresses how 
much accuracy the model losses by excluding each variable (Martinez-Taboada & Redondo, 
2020). Variable importance plots are often used to understand which variables are important in 
classifying the phenomena of interest which is helpful for this research to understand which 
independent variables are most important for classifying wetlands. 
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Report Body  
PROPOSED TASK BREAKDOWN AND SUMMARY OF PROJECT STAGES 
We conducted this research in stages that built on one another during the course of two years, the 
COVID pandemic notwithstanding. Table 3 shows a summary of the project tasks and the 
completion timeline. Each of the tasks is then detailed in the sections below and supplemented 
by two appendices (step-by-step project design, data collection, data pre- and post-processing 
and model classification and accuracy assessment sections included in a guide). 

Table 3. RP2020-04 research task breakdown showing % effort of total project hours, timeline 
for task start and completion and actual task completion date. 

 
 
TASK 
NO. 

ABBREVIATED TASK TITLE TASK 
AS A 

PERCEN
T OF 

TOTAL 
PROJEC

T 
EFFORT 

CUMUL
ATIVE 

PERCEN
T OF 
TASK 

COMPL
ETED 

SCHED
ULED 
TASK 

START 
DATE 

ACTUAL 
OR 

PLANN
ED 

TASK 
START 
DATE 

SCHED
ULED 
TASK 

COMPL
ETION 
DATE 

ACTUAL OR 
PLANNED 

TASK 
COMPLETIO

N DATE 

1 Project Design 6.7% 100% 08/19 08/19 12/19 06/30/20 
2 Field Work 17.9% 100% 10/19 10/19 12/20 03/31/21 
3 Image Processing 32.6% 100% 06/20 10/19 05/21 03/31/21 

4 Classification & 
Accuracy Assessment 

35.0% 100% 06/20 03/20 12/21 1/5/22 

5 Training & Final 
Deliverables 

7.8% 100% 05/20 05/20 12/21 12/30/21 

 

Task 1: Design Field Case Studies and Create and Manage Database and 
Server Configuration 
To justify the selection and purchase of a UAS LiDAR sensor selection, two LiDAR sensors, the 
Quanergy M8 and the Velodyne Puck were demonstrated for our project at NCDOT’s Beane 
Property in New Hanover County by LiDARUSA in March 2020. After a thorough analysis of 
the two datasets collected on the same day and using the same flight parameters (described in 
detail in the publication Pricope et al., 2020, published in the leading MDPI journal Sensors) and 
comparison of the specifications and price quotes between the two systems, we determined the 
Quanergy M8 to be the highest performing and most economical sensor and acquired the 
Quanergy M8 sensor. 

Figure 3 illustrates the three main stages of field work: study design preparation, and 
implementation in the field, and post field work data processing (see Appendix B for detailed 
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instructions in the “field manual”). In order for collections to achieve their intended goal, several 
pieces of field equipment must be prepared: 1) the fixed wing and multispectral camera property 
of Dr. Pricope’s Lab had to be prepared, 2) the LiDAR system needed to be prepared, 3) two 
Trimble RTKs were charged and loaded with GCP data and habitat sampling points, 4) and 
ancillary equipment including flight tablet, laptop, radios, also needed to be prepared. The flight 
mission planning for the LiDAR collection took place in the lab using ArcGIS Pro, while the 
flight mission planning for the multispectral collections was done using eMotion on a laptop. 
The photograph below shows us setting up the RTK static collection at Fort Anderson while 
preparing the other equipment for flight. 

 

Figure 3. Data collection workflow showing the three main stages of field preparation, 
operations on the day of fieldwork and post-fieldwork data download and equipment 
maintenance. 
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The flight planning for LiDAR collections is the most time-intensive aspect of preparing for a 
field collection. As detailed in our instructions manual (Appendix B), flight planning begins with 
a carefully selected study area that then becomes the area of interest (AOI) for all data collected 
at that respective site (Figure 4). The process of creation of a flight plan to be then uploaded to 
Ground Station Pro, the software on a typical tablet that is used to fly the Matrice 600 outfitted 
with the Quanergy M8 LiDAR sensor, is all conducted in ArcGIS Pro. The process outputs not 
only the flight path exported as a KMZ file, but also the required GCPs that intersect, as much as 
possible given accessibility and terrain conditions, the actual flight lines. 
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Figure 4. Typical pre-flight workflow for the creation of necessary outputs such as, the AOI 
boundary, flight path, and GCPs. 

In Figure 5 below, we then provide a schematic of how each of the outputs from the 
flight/mission planning and data collection planning stages translate into implementation 
components during the actual mission stages for both multispectral and LiDAR collections, 
along with a visual of an actual mission plan that was implemented at Masonboro Island (Figure 
6). 

 

Figure 5. Typical implementation of Figure 3 outputs for the collection of data during the 
photogrammetric and LiDAR flights. 
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Figure 6. An example flight mission map for Masonboro Island showing the area of interest 
(AOI) for a collection, flight path generated in ArcGIS Pro and uploaded to Ground Station Pro, 
and the Ground Control Points (GCPs) used for georeferencing. 

 
Upon mission completion and return from the field, much care is given to replacing all 
equipment into proper storage conditions, including recharging or discharging batteries for 
storage (see Appendix B, instruction manual), curating, downloading, and backing up all newly 
collected data on the local sever (with nightly backups to avoid any possible data losses) and 
beginning the organization of all collected data into proper folders and geodatabases. Once all 
data is properly organized and baked up, we begin creating metadata for each geodatabase 
indicated in Table 4 below. Metadata for each record was created using an ArcGIS Pro metadata 
template and each important component (date of acquisition, data type, attributes, who collected 
the data, etc.) with sufficient detail so that other users can easily understand and use these data. 
We recommend conducting proper data management, organization, storage, and backup as 
well as metadata attribution for any data collected in the field to ensure high data quality 
standards and data management. 
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Table 4. Structure of the data dictionaries utilized to organize the field collected data into sub-
folders and geodatabases (same folder structure that will be used for transferring all data 
collected and created from this project to NCDOT). 

SUBFOLDER 2ND SUBFOLDER DESCRIPTION OF CONTENTS 
CLASSIFICATION  

 
 
 
 

FIELDWORK_PREP mission_planning Planned drone flight path, AOI, and 
the target placement information 

FINALDATA classification  Classified dataset that contains the 
results of RF modeling 
 

 
 
 

in_situ_vector GCPs and flight path that are taken 
on the field. All the data came from 
LiDAR UAS 

 
 
 

Lidar Un/constrained lidar data which also 
came from eGPS (NAD83(2011),US 
State Plane, NC (3200) in Ft) 

 
 
 

multispectral  Green, nivi, nir, red, and red edge of 
reflection tif data that are processed 
in Pix4d (WGS84 /UTMzone 
18N(EGM96Geoid)) 

 
 
 

thermal Surface temperature (°C) tif data 
that are processed in Pix4d (WGS84 
/UTMzone 18N). 

PRE_PROCESS Sequoia_Pix4D Pix4D file to process multispectral 
data and its associated files 

 
 
 

SODA_Pix4D Pix4D file to process RGB data and 
its associated files 

 
 
 

Thermal_Pix4D Pix4D file to process thermal data 
and its associated files 

RAWDATA Lidar All the data here are given by eGPS 
and the equipment and the process 
they used were different from ours. 

 
 
 

multispectral  Raw multispectral data that were 
transferred from a Sequoia memory 
card 

 
 
 

RGB Raw RGB data that were transferred 
from a SODA memory card 

 
 
 

thermal Raw thermal data that were 
transferred from a ThermalMap 
memory card 

 
 
 

in_situ_vector Some in situ vector data associated 
with each site 

RESULT_VISUALS  
 
 

LiDAR visuals created from 
cloudcompare and global mapper 
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Task 2: Collect UAS data, conduct in-field calibration and conduct ancillary 
data collection (GCPs, habitat points, in situ multispectral imagery) 
 

In our original proposal to NCDOT, we committed to collecting data at least 9 sites throughout 
the Atlantic Coastal Plain along a gradient of wetland types representative of the palustrine to 
riverine to estuarine wetland types on the southeastern NC coast. Figure 7 shows the 9 sites we 
surveyed (the Masonboro island site was surveyed at two independent times, capturing both low 
and high tide conditions, hence being counted as two independent collections both in terms of the 
raw and derived data generated). 

 

Figure 7. Study area in southeastern NC showing the nine collection locations across four 
coastal counties. 

The equipment pictured below was utilized throughout the duration of this project to collect all 
field data: Matrice 600 Pro with the Quanergy LiDAR sensor, two Trimble RTK systems (R8 for 
static collection and R10 for GCP collection) and an eBee Plus RTK system outfitted with a 
Parrot Sequia multispectral camera. Table 5 provides a detailed summary of date each site was 
surveyed and respective dates of data pre-processing for each site. 
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Figure 8. Images of platforms used for data collection. (Left) DJI Matrice 600 Pro with 
Quanergy M8 LiDAR sensor, (Middle) Trimble RTK R8 and R10, (Right) fixed wing eBee with 
parrot sequoia multispectral sensor. 

 
UAS LiDAR platform and data collection 

The DJI Matrice 600 Pro was used to carry the 800 g Quanergy M8 LiDAR sensor along with a 
Zenmuse X3 camera to record in flight video for safety monitoring. The M600 Pro is a six – 
rotor unmanned aerial vehicle with an A3 Pro flight controller and Lightbridge 2 HD 
transmission system that can reach maximum speeds of 65 km/h. This was equipped with six 
TB48S batteries for increased flight time as well. The Quanergy M8 is an eight-laser scanner 
with a range of 150 m at an accuracy of 5 cm. It has a 360-degree horizontal field of view (FOV) 
and a 20-degree vertical FOV (Pricope, et al., 2020). The Trimble Real – Time Kinematic (RTK) 
R8 was used to collect static GPS data used for LiDAR processing and the Trimble RTK R10 
was used to collect the GCPs.  

Once each site was selected, the GCPs for each specific site were selected and generated along 
with the flight mission plan. Flight mission planning contains creating the flight path for each 
UAV and selecting where each GCP will be placed based on the flight path. Once these are 
created, the data was transferred to the Real – Time Kinematics (RTKs), tablets, and UAS. The 
equipment required was then charged. The day of fieldwork, the LiDAR UAS was flown to 
gather the raw LiDAR data and a static survey was conducted to gather the static data. Before the 
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static data could be collected, the GCPs were placed with the RTK systems to record their 
position.  

 

UAS Photogrammetric platform and data collection 

Another instrument used was the 1.3 kg fixed wing eBee plus RTK with a Parrot Sequoia 
multispectral sensor. The eBee has a wingspan of 116 cm with a ground sampling distance 
(GSD), at 122 m, of 2.5 cm. It can reach speeds of up to 110 km/h with a maximum flight time 
of 90 minutes. The parrot sequoia is a 4 - banded multispectral sensor plus RGB camera. The 
multispectral bands include green (550nm), red (660nm), red edge (735nm), and near infrared 
(790nm). The Trimble RTK R8 was used to collect static GPS data used for processing and the 
Trimble RTK R10 was used to collect GCP.  

The preparation workflow for photogrammetric data collection is like that of LiDAR in the 
section above. The flight paths and GCP collection with RTK systems are the same, however, the 
fixed wing eBee collected multispectral and RGB images instead of raw LiDAR data.  

Field Collection – Habitat Reference Points  
Habitat ground reference points (GRPs) were used as one of the two reference data (habitat 
points and NWI data) for training models and testing the wetland classification model accuracies. 
Habitat reference points were point data with wetland classes and their locational information. 
To minimize the human bias in selecting the locations of reference data, planned sample 
locations were generated before the fieldwork. The NWI dataset was used as reference data to 
map the distribution of wetland classes in study sites. Planned habitat points were generated 
using the Spatially Balanced Points tool in ArcGIS Pro. We generated 15 GRPs for each wetland 
class and 50 points for the non-wetland area to ensure that there would be enough data for the 
random forest classification. Because non-wetland areas include multiple areas of land such as 
upland grass, artificial objects, and open water, more habitat points were collected in these 
classes than the wetland classes.  

Habitat points were collected in the field (on the same day as the UAS surveys) using a Trimble 
R10 GNSS RTK System using the Topo points method. Habitat points were collected as close to 
the planned points as possible, and each point was recorded with a wetland class that was 
ground-verified. However, many of the planned points were physically impossible to access 
because of topography, vegetation cover, or inundation level during data collection. Therefore, 
after field work and back in the lab, the remaining habitat points were created using visual 
inspections of wetland class using the 2020 National Agriculture Imagery Program (NAIP) 
imagery for photointerpretation. The NAIP imagery is an open-source data and can be 
downloaded at the Geospatial Data Gateway of the United States Department of Agriculture 
(USDA) at https://datagateway.nrcs.usda.gov/GDGHome_DirectDownLoad.aspx. The 2020 true 
color NAIP imagery was the best option for this project because the LiDAR and habitat points 
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were collected in the same year or one year later (2020 and 2021). The remaining planned habitat 
points were overlaid with the true color 2020 NAIP imagery in ArcGIS Pro, and wetland classes 
were entered to the planned points as much as possible, including a confidence level. 

Table 5 provides a list of all sites surveyed, the dates the field work was conductedd and the 
dates all data processing was completed.  Table 6 contains all accuracy data for each site such as 
the vertical (RMSEz) accuracies of the LiDAR point clouds relative to ground control and check 
points and the horizontal (x,y) RMSE for the collected multispectral imagery, both computed in 
accordance with the ASPRS photogrammetry and LiDAR processing guidelines shared with our 
team by Wes Cartner at the DOT. All of the imagery and LiDAR data collected are within the 
class A accuracies for photogrammetric work as outlined in the ASPRS documentation.  

Table 5. Field Sites, Dates Surveyed, and Data Collected 

Site 
Name County 

DOT 
map
ped 
wetl
ands

? 

General 
Characteri

stics 

Field 
work 

date(s) 

Lidar 
UNCONSTR
AINED Point 

Cloud 
Processed 

Lidar 
CONSTRAI

NED 
Cloud 

Processed 

Thermal 
Processe

d 

Multi-
Spectra
l RGB 
(Soda) 

or RGB-
NIR-

RedEdg
e 

(Seqoui
a) 

Process
ed 

Numb
er of 
GCPs 
Collec

ted 

Numb
er of 
Habit

at 
Points 
Collec

ted 

Beane 
propert
y 

New 
Hanover Yes Managed 

forest 
1-Oct-

19 16-Nov-20 16-Nov-20 12/15/
2020 

11/13/2
020 5 N/A 

St 
James 

Brunswi
ck No 

Residentia
l 
developm
ent with 
managed 
wetlands 

5/12/20
20 2/15/2021 2/15/202

1 N/A 12/19/2
020 8 24 

Topsail 
High 
School 

Pender Yes 

Degraded 
wetlands, 
dense 
scrub/shr
ub 

6/2/202
0 5-Dec-20 5-Feb-21 3/5/20

21 
12/10/2

020 10 21 

Castle 
Bay GC Pender Yes 

Mixed 
managed 
wetlands, 
forest and 
mixed 
canopy 

6/29/20
20 2/5/2021 2/9/2021 12/5/2

020 
12/5/20

20 7 34 
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River 
Rd 

New 
Hanover No Fresh & 

Salt marsh 
10/1/20

-
10/3/20 

1/24/2021 5/27/202
1 N/A 12/19/2

020 11 29 

Surf 
City 
Bridge 

Pender Yes Fresh & 
Salt marsh 

11/6/20
20 12/14/2020 12/14/20

20 N/A 4-Dec-
20 15 18 

Mason
boro - 
High 
Tide 

New 
Hanover No Barrier 

island 
12/7/20

20 12/17/2020 12/31/20
20 N/A N/A 17 43 

Mason
boro - 
Low 
Tide 

New 
Hanover No Barrier 

island 
12/11/2

020 12/17/2020 

No, 
unconstra

ined 
RMSE is 

good 

N/A 5/31/20
21 17 43 

Maysvil
le 
Elemen
tary 

Jones Yes 

Freshwate
r 
managed 
wetlands, 
mixed 
forest 

1/22/20
21 1/28/2021 1/28/202

1 
2/25/2

021 
1/29/20

21 9 27 

Carolin
a Bays 
Parkwa
y 

Brunswi
ck Yes 

Freshwate
r 
managed 
wetlands, 
mixed 
forest 

2/23/20
21 2/26/2021 

No, 
unconstra

ined 
RMSE is 

good 

N/A 3/9/202
1 13 15 

Brunswi
ck 
Town/F
t 
Anders
on 

Brunswi
ck No 

Historic 
site, tidal 
riverine 
wetlands 

7-May 5/20/2021 

No, 
unconstra

ined 
RMSE is 

good 

N/A 5/7/202
1 10 N/A 

Bald 
Head 
Island 

Brunswi
ck No Barrier 

island 24-May In process In process N/A 5/28/20
21 6 N/A 

 

Once all data were collected, curated, backed up and properly attributed with metadata, we 
investigated the respective accuracy metrics for both the GCPs collected (Table 6A below for a 
summary of accuracy metrics for collected GCPs) and for the observed habitat/ground reference 
data (Table 6B) collected as validation for the wetland classification modeling.  

RTK GPS data collection was performed in three modes: static, survey and topographic. “Static” 
mode is when an RTK GPS is set up near the UAS flight take off/landing and runs throughout 
the flight operation. This RTK collection is used to add higher ortho accuracy to the collected 
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UAS data and is incorporated into the UAS data processing workflow (again, please refer to last 
quarterly report, 3/31/21).  GCPs are collected using “survey” mode which requires that the RTK 
unit remains stationary for at least 3 minutes prior to obtaining a waypoint/coordinate.  Lastly, 
“topo” mode is the fastest data collection method and therefore has lower horizontal accuracy. It 
is best to use this collection mode when the output does not require GCP accuracy for correcting 
imagery/UAS data. Therefore, we used “topo” mode to collect the field ground reference points 
(GRPs) which we have termed “habitat” points since these GRPs will be used in the 
wetland/habitat classification model.  

Trimble RTK GPS units can record several metrics that indicate the level of accuracy (both 
horizontal and vertical) using Dilutions of Precision (DOP). DOP is the measure of strength of 
the constellation of satellites at the time a waypoint is recorded where the lower the value the 
higher the accuracy of the recorded location: 

• PDOP: Position DOP, indicates the strength of the satellite constellation for general 
position accuracy 

• HDOP: Horizontal DOP, indicates the strength of the satellite constellation for 
horizontal position accuracy. 

• VDOP – Vertical DOP, indicates the strength of the satellite constellation for vertical 
position accuracy. 

• TDOP – Time DOP, indicates the strength of the satellite constellation for determining 
time and the clock offset. 

We have computed the average DOP and precision values for habitat GRPs and GCPs collected 
at each field site (Tables 6A and B below). As expected, the horizontal positioning is more 
accurate (lower DOP values) and greater precision than vertical positioning. Gathering more 
GRPs and GCPs does not lower the DOP values, the average HDOPs are less than 1 which is 
ideal, but less than 2 is considered excellent, and the standard deviation among the sites is very 
low which indicates that the DOP differences between sites is small. The average horizonal and 
vertical precision is also very good. These results are used to assist with developing the final map 
products because points with higher values can be removed from further processing.  

We recommend utilizing two RTK systems with capabilities to collect centimeter-level 
accuracy data for both static and GCP data as part of a defensible and accurate (to NC 
ASPRS standards of vertical and horizontal accuracy) field collection methodology. 

Table 6A and B. Field work accuracy for select sites in terms of Ground Control Points (GCPs) 
in table A and habitat reference points in B. 

SITE NAME NUMBER AVERAGE 
PDOP 

AVERAGE 
HDOP 

AVERAGE 
VDOP 

AVERAGE 
HORIZONTAL 
PRECISION 

AVERAGE 
VERTICAL 
PRECISION 
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Topsail High 
School 

10 2.179 0.9924 1.938 0.082 0.015 

Castle Bay GC 7 1.418 0.7375 1.212 0.007 0.013 

River Rd 11 2.094 1.092 1.778 0.009 0.02 

Surf City Bridge 15 1.477 0.7536 1.269 0.007 0.014 

Masonboro 17 1.35 0.6762 1.169 0.004 0.008 

Maysville 
Elementary 

9 1.451 0.7459 1.244 0.011 0.016 

Carolina Bays 13 1.83 0.9497 1.563 0.005 0.008 

SITE NAME NUMBER AVERAGE 
PDOP 

AVERAGE 
HDOP 

AVERAGE 
VDOP 

AVERAGE 
HORIZONTAL 
PRECISION 

AVERAGE 
VERTICAL 
PRECISION 

TOPSAIL HIGH 
SCHOOL 

21 1.357 0.685 1.170 0.015 0.028 

CASTLE BAY GC 34 1.881 0.936 1.626 0.013 0.025 

RIVER RD 29 1.640 0.908 1.361 0.010 0.014 

SURF CITY BRIDGE 18 1.654 0.822 1.433 0.014 0.024 

MASONBORO 43 1.397 0.765 1.167 0.009 0.014 

MAYSVILLE 
ELEMENTARY 

27 1.359 0.735 1.141 0.012 0.019 

CAROLINA BAYS 15 1.677 0.776 1.486 0.007 0.014 

 

Finally, the last component of field data testing, calibration and collection with the LiDAR 
equipment purchased with NCDOT funding has been to conduct multiple flights over the same 
area to determine the ideal flight altitude and overlap for future DOT missions. Graduate student 
Carter Eckhardt completed his MS Geoscience Final Project by testing LiDAR UAS parameters 
and comparing derived metrics in a 30-acre wooded area in the back of the UNCW campus, 
dominated with upland forest and forested wetland. Here we planned and collected data over 3 
days at three altitudes (50m, 65m, and 80m) and three percentages of sidelap (10%, 25%, and 
50%) (Figure 9). Research has shown that low altitude flight increases the spatial resolution of 
the resulting data, but requires longer flight time because of the greater number of flight lines 
and covers less area. Therefore, there is a cost to flying at lower altitude (Mesas-Carrascosa et al. 
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2016), yet altitude has also been determined as the most important flight parameter when 
collecting UAS Lidar (Sofonia et al. 2019) hence our tests to determine the most appropriate 
flight parameters for the system acquired through this contract.  

 
Figure 9. Planned flights at a 30 -acre site on the UNCW campus for testing altitude and swath 
width (percentage sidelap) of the Lidar UAS. Three altitudes (A- 50m, B- 65m and C- 80m) and 
three percentages of sidelap (10, 25, and 50) were tested for a total of 9 flights. 

 
Table 7. Post Flight Data from the UAS Matrice 600 based on each flight combination that 
processed successfully (excludes flight C at 80m altitude). 

Flight name Battery % used Flight airtime Battery sets Flight length (m) 
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A - 50 51% 14m 15s 1 3,514.04 

A - 25 47% 11m 05s 1 2,601.77 

A - 10 35% 09m 16s 1 1,920.55 

B - 50 56% 15m 35s 1 3,811.80 

B - 25 50% 11m 58s 1 2,786.15 

B - 50 40% 11m 26s 1 2,455.77  

Upon processing all data, the 80m altitude flight data did not process correctly and therefore was 
excluded; we do not recommend flying the Matrice with the Quanergy that high. The other 
critical flight parameters for the two other flight altitudes are reported in Table 7. For flights A 
and B (50m and 65m altitude respectively), graduate student Eckhardt ran geostatistical tools to 
analyze the resulting point densities and relative vertical information contained in the DEMs and 
DSMs generated at this site from the resulting point clouds for the dominant land covers in the 
AOI: forested, bare ground and mixed (Figure 10 A and B).  

 

 



42 | P a g e  
 

 

Figure 10. A: Average point density for the DSM based on each fishnet class. B: Average point 
density for the DEM based on each fishnet class. 

Findings showed that, compared to the computer simulated study by Bashar & Remondino 
(2020), flight overlap percentage does in fact influence point density more than altitude. This can 
be seen significantly when flight A-10 & B- 50 are compared, flight A-10 has similar point 
density to B-50 however the percentages of overlap are 10% and 50% respectfully.  The DSM, 
which includes the whole point cloud has a higher point density by area than the DEM. This is 
because the DEM only has the ground points which is the last return included in it and no other 
returns reducing the number of points by a significant amount. The point density between bare 
ground, mixed, and forested landcover indicates that the denser the vegetation, the higher the 
point density. The DSM classification shows a discrepancy between flight A and flight B where 
we notice a dip at Flight A – 25% compared to Flight A – 50%. The causes of this are unknown. 
When disregarding the discrepancy, we see a consistent increase from 10% to 50% of point 
density, however, when taking the flight time into consideration, the 50% overlap is significantly 
longer and uses more battery life than the 10% due to more transect lines in the flight path. For 
the DEM classification and point density, we note a constant increase from 10% to 50% overlap 
for both flight A and B (Figure 10B).   

For practical purposes, depending on the size of the area and the ideal point density desired, 
flight B at 50% has similar statistics to Flight A at 10% however an increase in clearance for the 
UAS may be needed in some areas making these parameters ideal. The negative impact of flight 
B at 50% is an increase in flight time and battery percentage used. Researchers have found that 
10 to 12 ground control points (GCPs) are recommended per 100 ha study area size (Yu et al. 
2020). However, Yu et al. (2020) did not consider the altitude of the UAS or the number of 
transect lines to be paired with the GCP targets of a certain study area size. Future work would 
include testing GCP locations based on the classified fishnet to test whether or not placing GCPs 
in certain areas (i.e., bare ground, mixed, or forest vegetation) would increase vertical RMSE 
accuracy of the point cloud. Some GCPs & checkpoints were removed due to being outliers or 
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having to large of a RMSE value to incorporate into the error. This was due to canopy cover and 
location of the GCPs & checkpoints, as well as fewer satellites and location loss of the Trimble 
R10 unit.   

After further conducting statistical t-tests on these flight combinations, depending on the 
majority landcover being surveyed, that multiple flight combinations will be suitable for data 
collection. We recommend that a forested landcover and mixed landcover should have a 
UAS flight parameter combination of an attitude at 65m with a swath width overlap 
percentage of 25%. This is due to the average point density of the DSM is 276 for mixed and 
344 for forested, as well as 96 for the DEM for the mixed & 45 for the forested. We recommend 
that for majority bare ground landcovers, the ideal flight parameter combination to be at 
50m altitude and an overlap percentage of 25%. This is due to the point density of the DSM is 
312 and the DEM is 213 (all statistically significant findings). 

Task 3: Image and Data Processing: Implement Photogrammetric 
Structure-From-Motion Processing Workflows on UAS Imagery and 
LiDAR Data Processing Workflows  
Final data deliverables (e.g. point clouds, DTMs, hillshades, orthomosaics, reflectance maps, 
vegetation indices, topographic indices, canopy heigh models) for all completed field sites: 
Topsail High School, Castle Bay, St. James, River Road (Wilmington), Surf City construction 
site, Masonboro island (two campaigns, one at high tide and one at low tide), Maysville 
elementary and the Carolina Bays parkway were all processed using standardized and repeatable 
methodologies detailed in the instruction manual (Appendix B). Figure 11 shows a summative 
flowchart from preparation to collection to initial processing for the LiDAR data, which is the 
focus of this research project. 

 

Figure 11. Workflow diagram showing the LiDAR collection process from field preparation to 
implementation and to the initial processing to obtain a point cloud constrained to GCPs. 

LiDAR data pre – processing  
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Given that the LiDAR scanner was completely new to our research team, there was a trial-and-
error period when we developed our understanding of not only how to properly pre-process, but 
also collect and manage the LiDAR data streams. Coupled with the COVID pandemic that 
started immediately after we had received the new equipment there was also a delay receiving it 
which led to some delay incorporating these new datasets into our project, mapping and the final 
modeling stages.   
 
The data collected from the LiDAR scanner, the static data from the GPS unit along with data 
collected from an Inertial Navigation System (INS) and the actual scanner (which includes the 
Inertial Measurement Unit (IMU)) were used in the LiDAR pre-processing steps. INS is a 
navigation method where estimations are given by accelerometers and gyroscopes are utilized to 
follow the position and direction of an object comparative to a known starting stage. The IMU 
uses drone telemetry to track the position and orientation of a device (Pricope, et al., 2020).  The 
raw Global Navigation Satellite System (GNSS) data is first converted from a T02 file to a 
RINEX file that is then brought into the Novatel Inertial Explorer. The GNSS data is processed 
in the Novatel Inertial Explorer where the Online Positioning User Service (OPUS) provides 
accurate solutions to the data collected from the flight. The OPUS - corrected GNSS data and the 
data collected from the sensor is then used to create a trajectory to estimate positional accuracy. 
The OPUS - corrected GNSS data and the data from the sensor is then coupled with the IMU 
data from the sensor to create a final flight trajectory. This data is then processed in LiDARUSA 
ScanLook PC to create an unconstrained point cloud (in LAS format) that can be used in other 
software packages (Pricope, et al., 2020).  
 
The point cloud is then analyzed in the Global Mapper software to locate and remove any errors 
such as excess noise, data gaps, and/or inconsistencies. The data is then brought back into 
ScanLook PC to constrain the point cloud to GCPs. A minimum of three ground control points 
GCPs with XYZ coordinates are required (Smith, et al., 2016). However, the numbers of GCPs 
depends on the size of the survey and there should be enough to cover the whole area, therefore, 
a larger number of GCPs might be needed (Javernick et al., 2014; Yu, Kim, Lee, and Son, 2020). 
One such study by Yu, et al. (2020), showed that the optimal number of GCPs for small and 
medium (7 and 39 ha) sites is 12 while for large (342 ha) sites it is 18.  
The point cloud is then brought back into Global Mapper to locate any more errors previously 
missed. Once all errors are found, the data are exported to multiple files in LAS format (Pricope, 
et al., 2020), see Figure 12. Step-by-step instructions for all stages of processing are included in 
the instructions manual in Appendix B of this report. 
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Figure 12. Summative workflow for the raw UAS LiDAR data pre-processing and processing to 
create digital terrain/elevation and/or digital surface models (DEMs) which can then be used to 
derive canopy height models for vegetation. 

Photogrammetric data pre – processing for multispectral data 

The typical workflow implemented, post fieldwork, using photogrammetric software packages 
will vary from one to another, but they all follow the standard format of three main phases: 
sparse point cloud reconstruction, georeferencing, and dense point cloud reconstruction (Berra & 
Peppa, 2020). This can be further specified into feature detection, key point correspondence, key 
point filtering, Structure from Motion, scaling and georeferencing, Multi – View Stereo, and 
georeferenced dense point cloud construction (Smith, et al., 2016).  
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The workflow being discussed was implemented by using the photogrammetric software Pix4D 
Mapper. Feature detection takes a set of images from different perspectives to identify key points 
in each image. This is most useful for SfM – MVS feature detection when images are taken from 
multiple viewpoints. Feature detection algorithms geometrically normalize regions containing 
similar features and correct illumination distortions to maintain invariance (Mikolajczyk, et al., 
2005). Key point correspondence requires the identification of similarities between features in 
multiple images. However, representation of these key points is not always guaranteed, therefore, 
a threshold must be applied.  

These thresholds can be complex; therefore, the algorithm will use distance ratios such as the 
Euclidean distance of the nearest neighbor. The pixel value closest to the predicted x,y 
coordinate is assigned to the output x,y coordinate. This uses a minimum value which looks to 
increase the chance of all features being identified. Filters are then applied to identify and 
remove inaccurate matches. If a feature is beyond the threshold, then it is considered an outlier 
and not fit for the algorithm. This is repeated until there is 95% certainty that there are no more 
outliers. Further filters are then applied to remove all outliers (Smith, et al., 2016). Using the 
corrected feature correspondences, SfM uses a bundle adjustment algorithm to estimate the 3D 
structure of an area. Smith, et al. (2016, p. 253) define bundle adjustment in two parts: Bundle 
as, “…the bundles of light rays connecting camera centers to 3D points” and adjustment as, 
“…the minimization of a non-linear cost function that reflects the measurement error”. The 
measurement error refers to the possible error created when each image feature is reprojected. 
The camera’s interior and exterior orientations are determined at the same to further minimize 
the reprojection error of all overlapping images (Berra & Peppa, 2020).  

At this stage the point cloud is sparse and not scaled to real - world units. A minimum of three 
ground control points (GCPs) with XYZ coordinates are required to fix this (Smith, et al., 2016). 
However, as discussed above, this depends on the size of the survey area and there should be 
enough GCPs to cover the whole area (Javernick, et al., 2014; Yu, et al., 2020). The information 
from the GCPs is then used with the internal constraints as external constraints to readjust the 
camera’s internal orientations, external orientations, and 3D coordinates to receive the desired 
coordinate system (Berra & Peppa, 2020). With the addition of external GCPs, the bundle 
adjustment can be re – run to reoptimize the image alignment and further minimizing the re – 
projection error. The last step in the SfM – MVS workflow is the use of MVS algorithms to 
produce dense point clouds. This algorithm usually increases the density of the point cloud by 
two orders of magnitude (Kholil, et al., 2021). Each pixel is triangulated and back projected to 
create a 3D surface. This georeferenced point cloud can then be exported to generate a digital 
surface model (DSM), digital elevation model (DEM), and/or a digital terrain model (DEM). 
Orthomosaics can be produced as well (Berra & Peppa, 2020), see Figure 13 below.     
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Figure 13. Summative workflow for the photogrammetric data pre-processing on the eBee 
collected multispectral imagery. 

Following the pre-processing methodologies outlined above, the final vertical (unconstrained and 
constrained to GCPs) RMSEz of UAS LiDAR point clouds and horizontal RMSEs for the 
multispectral UAS imagery are reported for all sites in Table 8. Beane property final metrics 
(processed by LiDARUSA) were also reported in detail in Pricope et al., 2020.  
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Table 8. Field site characteristics, vertical accuracies for both unconstrained and constrained 
Lidar point clouds, and horizontal accuracies for multispectral imagery. 

Site Name Location DO
T 

deli
neat
ed 

General 
Characterist

ics 

Field 
work 
date 

LiDAR 
RMSEz 

(m) 
Unconstra

ined 

LiDAR 
RMSEz 

(m) 
Constrain

ed  

Multispect
ral RMSE 
(m) X,Y 

Beane property New 
Hanover 
County 

Yes Managed 
forest 

1-
Oct-
19 

n/a 0.03 0.020 

St James Brunswick 
County 

No Residential 
with 

managed 
wetlands 

5/12/
2020 

0.187 0.34 0.024 

Topsail High 
School 

Pender 
County 

Yes Degraded 
wetlands, 

dense 
scrub/shrub 

6/2/2
020 

0.248 0.038 0.084 

Castle Bay GC Pender 
County 

Yes Mixed 
managed 
wetlands, 
forested 

6/29/
2020 

0.446 0.169 0.008 

River Rd New 
Hanover 
County 

No Fresh & Salt 
marsh 

10/3/
2020 

1.971 0.049 0.043 

Surf City Pender 
County 

Yes Fresh & Salt 
marsh 

11/6/
2020 

0.421 0.078 0.072 

Masonboro 
High Tide 

New 
Hanover 
County 

No Barrier 
island 

12/7/
2020 

0.42 0.044 Not flown 

Masonboro Low 
Tide 

New 
Hanover 
County 

No Barrier 
island 

12/11
/2020 

0.047 0.047 0.080 

Maysville Onslow 
County 

Yes Mixed 
forested 
wetlands 

1/22/
2021 

0.445 0.051 0.083 

Carolina Bays 
Parkway 

Brunswick 
County 

Yes Mixed 
forested 
wetlands 

with 
degraded  

2/23/
2021 

0.03 0.03 0.013 

 

Habitat Ground Reference Points (GRPs) 
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We used two Trimble RTKs to collect Static, Ground Control Points (GCPs), and habitat Ground 
Reference Points (GRPs). For the habitat GRPs, we used a spatially balanced structured random 
sampling design (Halls, Frishman, and Hawkes 2018; Theobald et al. 2007) to plan the field 
collection of GRPs based on the most recent NWI data. Even though the spatially balanced 
approach enables us to apply an accessibility weight to the random point locations, it was still 
very difficult to access many of the locations due to the nature of coastal wetlands; however, in 
total, we collected 225 GRPs at the 8 field sites. Accessibility issues are expected in this 
ecosystem; and therefore, the next step in the habitat GRP characterization was to use the 
planned habitat points and compare these with the most recent imagery to assess the planned 
points. Ultimately, we used these habitat GRPs for a final assessment of the wetland classes 
derived from the UAS lidar data.  

For each site, the planned habitat GRPs, collected habitat points, and imagery from three sources 
(NAIP, NC OneMap, and Google Earth) were used to update the points to the current habitat 
type and give an assessment of the confidence we have in these updated attributes. The workflow 
for this data processing is given in Figure 14, while an example resulting complete GRP dataset, 
along with the class definition used to create them are included in Figure 15 and Table 9. 

 

Figure 14. Data processing workflow to assign habitat classification to each planned Ground 
Reference Point. Each point was assigned a full NWI code, an abbreviated or generalized NWI 
code, as well as confidence rankings for both.  
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Figure 15. An example result of classifying the habitat Ground Reference Points (GRPs) using 
NAIP, Orthophotography and Google Earth to update the planned GRPs and give them a 
confidence ranking where 1 = unknown, 2 – less confident, and 3 = very confident in the habitat 
class. As shown in this example, most GRPs have a very high confidence and these points were 
used later in the project for wetland classification map accuracy assessment. 

Table 9. The definition of each NWI classes illustrated in the above figure is: 

NWI Definition 
PEM1Rd Palustrine, Emergent, Persistent, Seasonally Flooded-Tidal, Partially 

Drained/Ditched 
PFO1/3Cd Palustrine, Forested, Broad-Leaved Deciduous, Broad-Leaved 

Evergreen, Seasonally Flooded, Partially Drained/Ditched 
PFO3/1Cd Palustrine, Forested, Broad-Leaved Evergreen, Broad-Leaved 

Deciduous, Seasonally Flooded, Partially Drained/Ditched 
PFO1Cd Palustrine, Forested, Broad-Leaved Deciduous, Seasonally Flooded, 

Partially Drained/Ditched 
R1UBV Riverine, Tidal, Unconsolidated Bottom, Permanently Flooded-Tidal 
R5UBH Riverine, Unknown Perennial (the distinction between lower perennial, 

upper perennial and tidal cannot be made), Unconsolidated Bottom, 
Permanently Flooded  
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In summary, we recommend following standardized, repeatable and ideally batched data 
pre-processing workflows for all raw data collections, including for UAS LiDAR, 
multispectral/RGB/thermal and especially in situ reference data (as needed). We especially 
recommend that great care be taken when selecting the minimum required GCPs (5-
10/site, depending on the site characteristics and at least as many check points for 
validation) to ensure not only intersection with respective flight paths, but also accessibility. 
Data pre-processing templates and parameter specification sheets are imperative in 
ensuring standardized data processing across multiple sites. 

 

Task 4: Classification & Accuracy Assessment: machine learning random 
forest modeling 
To accomplish the last task of this project, UAS wetland classification, we collected various 
ancillary GIS and imagery datasets to use in the modeling, prediction, and validation of our 
wetlands classification (Table 9). As suggested in the literature review above and after testing 
several other classification approaches (tessellation-based, object-based), we settled on 
employing a pixel-based k-fold cross-validation random forest machine learning algorithm 
implemented in RStudio using the raster and h2o packages under the supervision and with 
support from Department of Mathematics and Statistics professors Drs. Tracy Chen and Yishi 
Wang. 

Table 10. Publicly available data sources assessed for project fit and/or used as ancillary data in 
different parts of this research project 

Data Purpose Pros Cons 

NOAA C-
CAP 

Land cover Few dates Low resolution for 
local analysis 

NWI Wetlands Detailed attributes Very outdated 

NC CREWS Wetlands Similar to NWI, but with 
emphasis on coastal 
wetlands 

Very outdated 

NAIP and 
other 
aerial/ortho 
photography 

Interpret Wetlands High resolution Usually only B&W or 
natural color, 
sometimes NIR 

PlanetScope 
& other 
satellite 
Imagery 

Can be used to derive 
wetland map 

Very high temporal 
resolution 

Can be expensive, data 
processing 
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NC DEM 
QL-2 Lidar 

statewide elevation can 
derive topography and 
other geomorphology 
variables 

Decent resolution (2m) Getting old (2020 QL-
1 is expected soon; 
1m) 

 

To determine the final best approach for modeling, graduate research assistant Asami Minei built 
a series of pixel-based random forest classifiers to predict wetland presence (binary 
classification) and wetland types (multi-class classification) using both NWI and habitat GRP 
data for training and validation. She compared the accuracy of UAS-collected LiDAR to QL2 
statewide LiDAR data at four of the total nine sites surveyed as part of this research project. 
Fourteen scenarios with various combinations of variables from two LiDAR datasets, 
multispectral, NWI, and habitat sample points were created for comparison (Table 10). For 
habitat models, only two patterns were tested because we realized that those two showed 
significant results in the process of constructing the NWI models. Settings for RF were tuned to 
increase the classification accuracy. Each resulting model was evaluated using overall accuracy, 
a standard deviation of accuracies, sensitivity, specificity, kappa coefficient, and map 
visualization. Additionally, a variable importance plot was produced to show each variable’s 
contribution to the random forest classification. 

Table 11. Random Forest modeling scenarios using both NWI and field-collected habitat data 
for training and testing purposes. Multispectral includes NDVI, NDRE, and NDWI, and the 
LiDAR datasets (QL2 and Quanergy) include DEM, DSM, smoothed DEM, Hydro-condition 
DEM, aspect, slope, curvature, plan curvature, profile curvature, flow direction, and flow 
accumulation. 

# Response Predictors 
1 NWI Binary Multispectral    
2 NWI Binary QL2 LiDAR   
3 NWI Binary Quanergy LiDAR   
4 NWI Binary QL2 LiDAR + Multispectral 
5 NWI Binary Quanergy LiDAR + Multispectral 
6 NWI Class Multispectral    
7 NWI Class QL2 LiDAR   
8 NWI Class Quanergy LiDAR   
9 NWI Class QL2 LiDAR + Multispectral 

10 NWI Class Quanergy LiDAR + Multispectral 
11 Habitat Binary QL2 LiDAR + Multispectral 
12 Habitat Binary Quanergy LiDAR + Multispectral 
13 Habitat Class QL2 LiDAR + Multispectral 
14 Habitat Class Quanergy LiDAR + Multispectral 

 
Asami Minei’s Master’s thesis (which can be provided upon request in its entirety) evaluated the 
potential of UAS LiDAR data integrated with the various field-derived datasets to understand the 
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extent, location, and type of North Carolina Coastal Plain wetlands. Based on that work, we drew 
several conclusions that guided the final modeling for this report:  

1. Based on the results of model performance scores across the 14 models tested at 4 of the 
sites (overall accuracies, kappa coefficients, and visual comparisons), the classification 
models derived from the hyperspatial Quanergy LiDAR data and multispectral datasets 
showed better performance than the statewide QL2 data. Models trained by field-
collected habitat GRPs were more accurate than the models trained by NWI data. 
Therefore, the models derived from Quanergy + MS data and habitat reference data 
performed the best in terms of visual comparison and statistical scores. However, 
NWI data used for training can perform better than the habitat points when not enough 
habitat points were collected or when the landscape being mapped has not changed 
significantly for a few decades as was the case with Masonboro island. As such, we used 
only the Quanergy LiDAR data collected by our team along with the UAS multispectral 
data trained by GRPs (habitat points) and NCDOT delineated wetlands (where 
available) for our final modeling in this report. 

2. We show that even with a small number of field-verified point data (GRPs), we can 
create an accurate wetland map through a random forest algorithm, however, more 
habitat points would improve the overall accuracies and class-specific sensitivities and 
specificities.   

3. The resulting variable importance plots show that the elevation variables and 
vegetation indices are the most important predictors of wetland presence overall 
(Figure 16). As such, given the patterns revealed by this modeling work, we decided 
against including flow direction and flow accumulation as variables in the final wetland 
classifications in this report. 
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Figure 16. Variable importance plot shows the relative contribution to the habitat multi-class 
model made by the Quanergy and multispectral variables for the River Road site, New Hanover 
County. 

 
For all sites and results presented in section Findings and Conclusions below, we used the raster 
and h2o packages in R to construct Random Forest models. R is an open-source programming 
language developed for statistic computing and graphic, and the h2o package is a machine 
learning platform developed specifically to tackle computational issues that are common with big 
datasets. This package was chosen as the machine learning platform because some of the raster 
stacks had ~5 million pixels within the study area, which caused computational difficulties with 
other random forest packages in R. A raster stack was imported into R and converted from a 
raster format to a data frame, which contained all variables as columns and each pixel sample as 
rows. The number of records (number of pixels within AOI) in the data frame varied based on 
raster pixel size and the number of reference data. For example, if habitat sample points 
contained only 58 points, the raster stack only has 58 pixels for training and testing. Two 
important parameters that are tuned in the model are: the number of decision trees to grow 
(ntree) and the number of variables randomly sampled as candidates at each tree node (mtry). 
Ntree was set to a default number of 500 and mtry was set to the same number as the number of 
the input predictors since there were only fourteen predictors total. We provide the final tuning 
parameters in Appendix A. The following parameters were included in the raster stacks for each 
site: 

A. LiDAR data (LAS data) is a point cloud of elevation data, was used to create 
topographic layers and a canopy height model (DSM-DEM). 

1) Digital Surface Model (DSM) 
2) Digital Elevation Model (DEM) 
3) Canopy Height Model (CHM) 
4) Smoothed DEM (sDEM) 
5) Hydro-condition DEM (hDEM) 
6) Aspect 
7) Slope 
8) Curvature 
9) Plan Curvature 
10) Profile Curvature 

B. Multispectral imagery (green, red, red-edge, and near-infrared) (TIF data) was used to 
create three vegetation indices. 

1) Normalized Difference Vegetation Index (NDVI) 
2) Normalized Difference Red Edge Index (NDRE) 
3) Normalized Difference Water Index (NDWI) 
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C. Habitat point (GRP) data collected in the field and using ancillary data analysis. In 
order to use the habitat sampled data as training for our final RF model, the following 
steps have been undertaken: data consolidation (such as classes UB – unconsolidated 
bottom - or US –unconsolidated shore – into one water class; conversion of the vector 
data into a raster dataset (snapped to and matching the resolution of the topographic 
layers); and finally, inclusion of this training layer based on the field habitat data into the 
final raster stack dataset containing the 14 layers detailed below using the composite 
bands tool in ArcGIS Pro (Table 11). 

Table 12. Final 14 layers included in each raster stack to be imported into R that was used for all 
final models for all sites with the respective variable names. 

1 HABITAT 
2 DEM 
3 sDEM 
4 hDEM 
5 DSM 
6 CHM 
7 Aspect 
8 Slope 
9 Curvature 
10 PlanCurv 
11 ProfileCurv 
12 NDVI 
13 NDRE 
14 NDWI 

 

Figure 17 shows the wetland classification workflow beginning with the raw Quanergy and 
multispectral data and ending with the model evaluation metrics, prediction maps and variable 
importance plots presented in the next section below. From the overall point clouds, we derived 
cross-sectional views for all four sites and show the across-site variability and ability of the data 
to capture both vertical vegetation structure in the tree-dominated sites as well as the underlying 
topography of swales and ridges of the more estuarine sites dominated by grasses (Figure 18). 
Unlike prior modeling efforts of coastal wetlands, we created a canopy height model (CHM) to 
account for wetland vegetation height given the large gradient in vegetation structure existing in 
our region (Figure 18). 
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Figure 17. Wetland classification workflow based on the Quanergy LiDAR data, multispectral 
reflectance data and reference habitat points applied to all sites surveyed for this project. 
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Figure 18. Example cross-sections of vertical vegetation structure of wetlands located along a 
palustrine to estuarine gradient. A-B: Surf City, C-D: Masonboro Low Tide (LT) at back barrier 
marsh, E-F: Masonboro LT at dunes, G-H: Topsail High School showing the gradient in 
vegetation structure that could be resolved from our UAS LiDAR data. 

After ensuring all the data is snapped properly and within the AOI of each collection site, we 
used the RStudio (https://www.rstudio.com/) programing platform (step-by-step instructions, as 
well as the code utilized are provided in Appendix A of this final report).  Once all the raster 
stacks were prepared, the K-fold cross-validation (CV) method was used for the random forest 
algorithm in this study (Figure 19). CV is a widely used resampling method because it assesses 
the general performance and stability of predictive models and prevents overfitting (Berrar, 
2019). In this study, Random Forest classification was conducted using a 5-fold CV. First, the 
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dataset (including training and testing datasets) was randomly shuffled and divided into five 
folds. For the first run, we removed fold 1 and used the remaining four parts to train a RF model. 
Then, fold 1 was used to calculate the classification accuracy. This process was repeated four 
more times with different training and testing set each time. The 5-fold CV method produces five 
RF models with five classification accuracies, so the average of five accuracies (overall 
accuracy) and the standard deviation of the five accuracies was calculated as performance 
metrics. Post-processing consisted of generating performance metrics and prediction maps. There 
were five model performance metrics that were calculated: averaged overall accuracy, the 
standard deviation of accuracies, kappa coefficient, sensitivity, and specificity (Table 12; Table 
13). Since the overall accuracy was computed by averaging five model accuracies from the 5-
fold CV resampling method, the standard deviation of accuracies was calculated to evaluate the 
model consistency. Additionally, kappa coefficients, sensitivity (true positive rate), and 
specificity (true negative rate) were calculated from a confusion matrix table. The resulting 
Random Forest prediction model was made in a raster format and visualized using ArcGIS Pro.    

Table 13. Description of performance metrics for the random forest modeling used for this 
study. 

Performance metrics Description 
Averaged Overall Accuracy (AO) The overall accuracy of each 5-fold cross-validation is 

calculated by summing the number of correctly classified 
values and dividing by the total number of values. 

Standard Deviation of Accuracies 
(StD) 

The StD of five accuracies is a measure of how dispersed the 
data is in relation to the mean. Large StD means the data are 
spread (models are unreliable) and vice versa. 

Kappa Coefficient (k) This index is for assessing agreement between the model and 
the reference data. It ranges from -1 to 1. 

Sensitivity Sensitivity, true positive rate, measures how often a model 
correctly generates a positive result for areas that are wetlands 
(for wetland binary classification).  

Specificity Specificity true negative rate is the proportion of areas that are 
not wetlands out of all areas (for wetland binary classification). 
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Table 14. Explanation of the Kappa Coefficient values and level of agreement as reported in the 
next section below. 

Value of k Level of Agreement 
-1.0 ─ 0.0 No agreement 
0.01 ─ 0.20 None to slight 
0.21 ─ 0.40 Fair 
0.41 ─ 0.60 Moderate 
0.61 ─ 0.80 Substantial 
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Figure 19. Example derived input layers that went into each respective raster stack, shown here 
for the Carolina Bays site. 

 

Task 5: Training & Final Deliverables 
The final task of your project was completed in person on the UNCW campus on Nov 16 and 
17th 2021 and all training materials were handed over to participating DOT personnel. The final 
version of the training manual has been updated last on January 24th 2022 and is included as an 
appendix (Appendix B) to the final report. 
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Findings and Conclusions  
Model performance  
We anticipated that the DEM, topographic indices and vertical vegetation structure metrics 
derived from the UAS-borne LiDAR would substantially improve models of wetlands 
predictions and delineation in Coastal Plain environments that cover a gradient of wetland types 
and our results below overall show exactly that. We report the model performance, final 
classification maps relative to the habitat GRPs and NCDOT-delineated wetlands (where 
available) and variable importance plots for each site surveyed during the duration of RP2020-04 
in the section below, site by site. Overall, we quantitatively compare the model performance 
metrics (overall accuracies, standard deviation of overall accuracies, kappa coefficients, 
sensitivities, and specificities) and the model prediction maps that were made by the hyperspatial 
UAS LiDAR (Quanergy M8) against habitat sample data.  

Overall, the wetland classification models derived from the Quanergy and multispectral 
data performed the best based on visual comparisons and the performance metrics. 
Standard deviations of overall accuracies provide a measurement of model stability to the overall 
accuracies. In line with previous research, we detected small improvements in model accuracies 
when multispectral variables were added to the LiDAR variables, which was the same results by 
(Rapinel et al., 2015). Although the addition of multispectral variables did not increase the 
overall accuracies significantly, multispectral data helped stabilize the models.  

The class-specific sensitivities and specificities for each site were improved by using habitat 
points. However, some of the classes of the habitat models still produced low sensitivities. We 
hypothesize that the low sensitivities were caused by a small area for the training and testing 
areas. For example, the area of palustrine scrub/shrub and water were only 0.58% and 1.18% 
respectively out of the whole study sites. This indicated that it is more difficult to classify small 
areas than classify larger areas. The details and the quality of the final prediction maps generated 
depend on the spatial resolution of datasets, response variables, and respective predictors. When 
compared to the most recent NWI data (see all figures below), the results of our prediction maps 
showed much more distinct and resolved wetland class patterns because of the very fine spatial 
resolution of the UAS data utilized.  

Variable Importance  
The second research objective for the modeling component of this project was to determine the 
most important variables (and minimum number of predictor variables) that help classify the 
Coastal Plain wetlands and that capture the characteristics of the various study areas we 
surveyed. Variable importance plots show the ranking of variable importance based on the mean 
decrease accuracy of the models and were created for each model. Elevation variables (DSM, 
DEM, smooth DEM, and hydro-condition DEM), canopy height models and vegetation 
indices (NDVI, NDRE, and NDWI) were always ranked within the top five. Hydrological 
variables such as flow direction and flow accumulation were the opposite, resulting in the least 
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important variables, hence we excluded them from these final model runs. Since the 
characteristics of the Coastal Plain area are flat areas with aquatic vegetation, those results match 
the characteristics of this area. The results also showed that the addition of multispectral data 
largely contributed to the models by vegetation indices being ranked as one of the top variables.  

Presented below are classification maps, variable importance plots, and sensitivity/specificity 
graphs for each site (Figures 20 through 38).  

 

Figure 20. The wetland classification breakdown utilized in the final classification maps below. 
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St James Plantation, Brunswick County, NC (date surveyed May 12th 2020) 

 

Figure 21. Random forest wetland classification map at St James study site. 
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Figure 22. The top chart shows the variable importance plot generated for St James, while the 
bottom chart shows the model sensitivity and specificity for each class. 
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Topsail High School, Pender County, NC (date surveyed June 2nd 2020) 

 

Figure 23. Random Forest wetland classification map at Topsail High School study site. 
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Figure 24. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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Castle Bay, Pender County, NC (date surveyed June 29th 2020) 

 

Figure 25. Random Forest wetland classification map at Castle Bay study site.  
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Figure 26. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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River Road, New Hanover County, NC (date surveyed October 3rd 2020) 

 

Figure 27.  Random Forest wetland classification map at River Road study site. 
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Figure 28. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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Figure 29. Random Forest wetland classification map at Surf City study site. 
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Figure 30. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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Masonboro High-Tide Survey, New Hanover County, NC (date surveyed December 7th 
2020) 

 

Figure 31. Random Forest wetland classification map at Masonboro study site (high tide). 
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Figure 32. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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Figure 33. Random Forest wetland classification map at Masonboro study site (low tide). 
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Figure 34. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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Maysville Elementary, Jones County, NC (date surveyed January 22nd 2021) 

 

Figure 35. Random Forest wetland classification map at Maysville study site. 
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Figure 36. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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Carolina Bays parkway, Brunswick County, NC (date surveyed February 23rd 2021) 

 

Figure 37.  Random Forest wetland classification map at Carolina Bays study site. 
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Figure 38. The top chart shows the variable importance plot generated for this site, while the 
bottom chart shows the model sensitivity and specificity for each of the classes represented at 
this site. 
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Overall Study Modeling Statistics 
In summary, the Random Forest UAS classification model performed very well and varied 
across the study area (Figures 39 and 40 and Tables 14 and 15). The estuarine sites (Masonboro 
and Surf City), with no dense forest canopy, had the highest wetland classification accuracy, but 
these sites also have the most difficult tidal challenges and as such these results are very good. 
The two sites with the lowest classification accuracy were Topsail High School which had the 
lowest number of points we were able to collect in the field and Castle Bay was a mixed forested 
wetland environment, very challenging to field check, and also included a golf course and 
therefore the image classification was difficult. 

 

Figure 39. Comparison of the overall model classification accuracies and Kappa coefficients for 
all sites surveyed during this project. 
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Figure 40. The overall distribution of model accuracies by sites with bars indicating the 
respective standard deviation of each model. 

Table 15. Summary of overall model accuracy, standard deviation of overall accuracies, Kappa 
coefficient, and number of total GRPs for each of the nine sites surveyed. 

Site Name Overall 
Accuracy 

StD Kappa 
Coefficient 

Number of 
Total GRPs 

St James 78.70% 0.13 67.64% 108 

Topsail High 63.33% 0.15 53.34% 91 

Castle Bay 66.46% 0.10 56.24% 172 

River Road 76.30% 0.06 69.48% 137 

Surf City 77.07% 0.06 69.21% 157 

Masonboro-HT 85.62% 0.08 78.20% 153 

Masonboro-LT 82.24% 0.02 73.12% 153 

Maysville 76.25% 0.11 63.34% 81 

Carolina Bay 70.59% 0.18 52.25% 34 
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By class, the post classification accuracy assessment is influenced by the number of habitat 
GRPs there were in each class. Therefore, classes that occupied smaller portions of the study 
areas, and therefore had far fewer GRPs generally also had lower accuracies. For example, water 
was only a small portion of several study areas.  However, when developing a land cover 
classification model there is always a point during the process when the goals for deriving the 
best classification model for the purpose of the project objective exceeds the viable number of 
accuracy assessment points.  In this case, during model development we tested the binary 
wetland/non-wetland model selection and the accuracy results were excellent. The next step was 
multiple wetland classes, but the non-wetland areas, which were not in the original plan for the 
project, were being misclassified in the Random Forest model and as such this necessitated that 
we return to the habitat GRPs and reclassify the non-wetland habitat GRPs and classify these as 
“open” if they were located in areas dominated by bare ground. This substantially reduced the 
number of non-wetland GRPs for these two classes but greatly increased the RF classification 
model performance.  

Table 16. Summary table showing the class-level model sensitivity, specificity, user’s, and 
producer’s accuracy for the nine sites surveyed during this project. 

Site Name Wetland Class Sensiti
vity 

Specifi
city 

User's 
Accur
acy 

Produ
cer's 
Accur
acy 

Area 
Percen
tages 

# Of 
GRPs 

St James Palustrine Forested 73.81% 84.85% 75.61% 73.81% 30.63% 42 
  Non Wetland - Open 85.71% 95.00% 85.71% 85.71% 20.16% 29 

  
Palustrine 
Scrub/Shrub 78.95% 87.14% 76.92% 78.95% 49.20% 37 

Topsail 
High Non Wetland 69.23% 82.81% 62.07% 69.23% 25.82% 27 
  Non Wetland - Open 64.71% 93.15% 68.75% 64.71% 16.62% 17 

  
Palustrine 
Forested/Scrub/Shrub 52.94% 89.04% 52.94% 52.94% 21.40% 17 

  Palustrine Forested 53.33% 94.67% 66.67% 53.33% 17.96% 15 

  
Palustrine 
Scrub/Shrub 73.33% 93.33% 12.50% 73.33% 18.18% 15 

Castle Bay Non Wetland 16.00% 94.12% 33.33% 16.00% 6.83% 25 
  Non Wetland - Open 82.22% 87.93% 72.55% 82.22% 35.97% 45 
  Palustrine Forested 78.26% 86.09% 69.23% 78.26% 40.04% 56 

  
Palustrine 
Scrub/Shrub 80.00% 95.21% 63.16% 80.00% 5.58% 15 

  Water 62.07% 93.18% 66.67% 62.07% 11.54% 30 

  Palustrine Emergent 0.00% 
100.00
% 0.00% 0.00% 0.05% 1 

River 
Road Palustrine Forested 62.50% 85.26% 64.10% 62.50% 27.68% 40 
  Palustrine Emergent 85.29% 91.09% 76.32% 85.29% 45.53% 34 
  Non Wetland 80.00% 96.67% 75.00% 80.00% 6.96% 15 
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  Non Wetland - Open 84.00% 97.27% 87.50% 84.00% 14.80% 26 
  Water 76.19% 98.25% 11.11% 76.19% 5.02% 22 
Surf City Non Wetland 62.50% 91.67% 84.62% 72.13% 34.67% 61 
  Palustrine Forested 85.29% 88.24% 67.44% 76.32% 33.22% 38 

  
Estuarine Intertidal 
Emergent 80.00% 92.13% 73.68% 93.33% 29.05% 30 

  
Palustrine 
Scrub/Shrub 84.00% 97.92% 62.50% 38.46% 1.46% 13 

  Water 76.19% 99.30% 0.00% 
100.00

% 1.60% 15 
Masonbor
o-HT Water  83.93% 95.88% 92.16% 83.93% 31.95% 56 

  
Estuarine Intertidal 
Emergent 82.93% 94.64% 85.00% 82.93% 41.07% 41 

  Non Wetland 89.29% 87.63% 80.65% 89.29% 26.97% 56 
Masonbor
o-LT Water 83.93% 96.91% 93.18% 74.55% 32.22% 56 

  
Estuarine Intertidal 
Emergent 82.93% 92.79% 80.95% 82.93% 39.72% 41 

  Non Wetland 89.29% 83.33% 75.76% 89.29% 28.06% 56 
Maysville Non Wetland - Open 86.11% 93.18% 91.18% 86.11% 47.50% 36 
  Non Wetland 58.82% 92.06% 66.67% 58.82% 13.24% 18 
  Palustrine Forested 80.00% 80.00% 64.52% 80.00% 36.71% 25 

  Water 0.00% 
100.00
% 0.00% 0.00% 2.55% 2 

Carolina 
Bay Non Wetland 83.93% 84.21% 80.00% 80.00% 35.88% 15 
  Non Wetland - Open 82.93% 80.95% 73.33% 84.62% 54.21% 13 
  Palustrine Forested 89.29% 89.29% 25.00% 16.67% 9.91% 6 

 
Challenges, Limitations, and Future Directions  
It was difficult to establish the overall best methodology for the modeling component of this 
research. We started out using a tessellation approach to generalize the data into a small area to 
avoid the computational intensity for random forest models. We switched from a tessellation to a 
pixel-based approach quickly after finding out that this approach lost a lot of the very high 
spatial details contained by the Quanergy data. Then, we encountered computational memory 
and space difficulties using the pixel-based classification, but we figured it out by using a 
different computer with more memory and an R package that was developed to deal with big 
data.  

One limitation of this research is to create high-quality response variable data given the relative 
outdatedness of the NWI wetland extent data for North Carolina. Accurate, most-updated 
Ground Reference Points (GRPs) sample data are needed to create a high-quality and accurate 
wetland classification. However, the collection of ground-truthing data was difficult because of 
the topography and general inaccessibility of the sites we surveyed. There were some areas that 
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we could not access because of the mud cover and some areas could not be validated because of 
the very dense canopy cover when doing visual inspection using NAIP imagery to create 
additional training and validation data. Therefore, if the ultimate goal is to increase the accuracy 
of Coastal Plain wetland prediction models, improvements to the quality of response data will 
continue to be a high priority for any future mapping and modeling project utilizing UAS 
technology. Polygon sample data could be used, instead of point data, to encompass the larger 
area of sample data (Kolarik et al., 2020; Gaughan et al., 2022). Lastly, different machine 
learning classifications can be tested to compare the model performance, such as different 
ensemble methods such as gradient boosting would be a great start. However, most advanced 
machine learning modeling approaches do require a good amount of training data that can be 
obtained either in the field or using on-screen digitization approaches, both exemplified in this 
work and final report. 

 

Recommendations  
As discussed in the pages of this report, we make a series of summary recommendations for each 
task/section. In terms of project design and preparation, we recommend conducting proper data 
management, organization, storage and backup as well as metadata attribution for any data 
collected in the field to ensure high data quality standards and data management. For the purpose 
of mission implementation and data collection, in addition to required FAA and NCDOT legal 
and operational safety parameters, we recommend utilizing two RTK systems with capabilities to 
collect centimeter-level accuracy data for both static and GCP data as part of a defensible and 
accurate (to NC ASPRS standards of vertical and horizontal accuracy) field collection 
methodology and so that data processing proceeds smoothly. In terms of more specific flight 
parameters for UAS LiDAR collections, we recommend that in a forested landcover and mixed 
landcover area you should have a UAS flight parameter combination of an attitude at 65m with a 
swath width overlap percentage of 25%.  Second, we recommend that for majority bare ground 
landcovers, the ideal flight parameter combination to be at 50m altitude and an overlap 
percentage of 25%.  

For the important components that pertain to data pre-processing, processing, and initial analyses 
and visualizations of UAS-derived data (LiDAR and imagery based, along with the requisite in 
situ components), we recommend following standardized, repeatable and ideally batched data 
pre-processing workflows for all raw data collections, including for UAS LiDAR, 
multispectral/RGB/thermal and especially in situ reference data (as needed) and we especially 
recommend that great care be taken when selecting the minimum required GCPs (5-10/site, 
depending on the site characteristics, as well as the collection of 75-100% as many check points 
for validation) to ensure not only intersection with respective flight paths, but also accessibility 
to the site locations. Data pre-processing templates and parameter specification sheets are 
imperative in ensuring standardized data processing across multiple sites. 
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Finally, for taking the raw data and creating mapping or modeling products, irrespective of the 
software package to be used, we recommend collecting high spatial resolution data aided by 
other ancillary datasets, whether UAS-based or not. As such, we showed that Quanergy LiDAR 
data collected by our team along with the UAS multispectral data trained by GRPs (habitat 
points) and NCDOT delineated wetlands (where available) created spatially-accurate wetland 
delineations when compared to NWI data. Even though we were able to use random forest 
algorithms to create these classifications with only a small number of field-verified point data 
(GRPs), we recommend that more habitat points be collected if overall accuracies and class-
specific sensitivities and specificities are required for NCDOT mapping projects at specific sites. 
Because we used random forest modeling, we were able to create variable importance plots for 
each type of wetland site surveyed and show that the highly resolved elevation variables, 
vegetation height and vegetation indices are the most important predictors of wetland presence 
overall. As such, given the patterns revealed by this modeling work, we decided against 
including flow direction and flow accumulation as variables in the final wetland classifications 
given the relative flat topography of the Atlantic Coastal Plains regions; this, however, would be 
different for sites characterized by more variable topography. 

 

Implementation and Technology Transfer Plan  
The main research products generated from this project include a ready-to-fly and operate UAS 
LiDAR system that has been thoroughly tested and comes with step-by-step operation 
instructions, fixed-wing UAS multispectral data and derived vegetation indices, in situ GCP and 
GRP point data, metadata and data dictionaries for all datasets, and final machine learning 
classification products that can be compared to existing DOT datasets and other potential future 
delineations.  

Given that the goal of this project was to provide NC DOT with detailed approaches to using 
UAS technologies to derive maps of environmental features (not just wetlands), we worked 
synergistically with NC DOT so that the products are directly applicable to assisting the 
Environmental Analysis Unit at DOT in the implementation of project planning and 
development. Therefore, at all stages of this project, our team has done our best to include one or 
more NC DOT staff in providing guidance, meet at our regularly scheduled meetings, work in 
the field when available so that the full UAS flight process and collection of ancillary data were 
thoroughly understood, review GIS and data products, and participate in technology transfer 
through a two-day workshop completed before the project ended. The UNCW team feels that we 
have been successful if the products from our case studies will have been used in NC DOT 
project planning.  

Second, to ensure adequate technology transfer, not only did we hold a two-day training 
workshop, but we made every effort for NCDOT staff to be comfortable using the UAV 
equipment as well as processing data to produce cartographic products and GIS data that can be 
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directly imported into NC DOT enterprise databases during the entire duration of the project, in 
addition to bi-weekly progress report meetings. At the completion of this project, we are truly 
grateful for the opportunity to work on this project and we strongly believe that the correct use of 
UAS technology can save NC DOT money, long-term, by implementing a strategy that reduces 
the number of days that surveyors are currently out in the field. However, as our discussion of 
limitations and modeling section above underscore, this technology is not a replacement for 
surveying, it is a means of utilizing aerial approaches to highlight and map potentially sensitive 
resources that can then be surveyed and incorporated into the project planning and workflow 
processes by NCDOT teams across multiple divisions. 
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Appendices  

APPENDIX A: RANDOM FOREST ANALYSIS SCRIPT AND STEP-BY-STEP 
INSTRUCTIONS 

We will use the R language to run random forest analysis. RStudio 
(https://www.rstudio.com/), programming platform, is used throughout this guide. 

RASTER TO DATA FRAME 
1. Create a file for this step and put “RasterToDataFrame.R” and stack tifs. 

 

2. We are going to convert the raster layers into data frame, which is the most common 
dataset format used in R. Open the “RasterToDataFrame.R” file in RStudio. 

3. Run the “1. setting environment” section. Make sure you change the work path before 
you run it. 

 

4. Run the “2. Load and name” section. Make sure you change the name of the tif file 
exactly as you named it. 

https://www.rstudio.com/
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When you run line 42, all the raster layers were plotted in the plot window. 
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This is the zoomed in the Habitat layer. Since the pixels were too small, you cannot see 
anything. But you can see that there are three classes stored in this data based on the scale 
bar. 

 

 

5. Run the “3. Convert the raster into DataFrame” section.  

 

 

6. Save the dataframe as RDS dataset. 
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RANDOM FOREST CLASSIFICATION USING H2O 
1. Create a folder and put those files like shown below. 
• Wetland_RF_H2O.R 
• SiteName_all.rds 
• SiteName_hab.rds 
• SiteName_Stack.tif 

 

2. Open the “Wetland_RF_H2O.R” and run the “1. Setting environment” section. You 
only install packages once in your computer but run library every time you run. 

 

3. Run the “2. Load RDS data” section. Make sure to change the path to the folder (fb <- 
folder path) and change the name of the RDS file. 
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4. In like 21, select only variables (remove the x and y coordinate).  Here we use H2O 
package to run random forest analysis. Make sure to run line 25 – 27 every time when 
you are out of memory. 

 

 

When you run rforest.model, this is what you get: 

Model Details: 

============== 

 

H2OMultinomialModel: drf 

Model ID:  DRF_model_R_1641325516784_1 …….. 
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5. Run the “4. Save model as file” section. Change line 68, 69 as accordingly. When you 
save the model, it will be saved as the model ID in the folder. For line 72 and 73, you can 
see the variable importance. 

 

 

6. Next step is to use the random forest model that was created in the previous section, 
predict wetland classification with all the areas. Make sure to change the line 80 
accordingly. Also, line 89-91 can tell you how long the model took to train and predict. 
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7. Run the section 5 to save the x, y, and prediction results for the training data. Make sure 
you change the line 99 and 100 as you like. 

 

 

8. S 
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APPENDIX B: FINAL UNCW UAS DATA COLLECTION, PROCESSING AND 
MMODELING MANUAL WITH STEP-BY-STEP INSTRUCTIONS  
 

 

DATA COLLECTION, 
PROCESSING AND MODELING 
GUIDE FOR LIDAR UAS AND 

IN SITU FIELD DATA IN 
SUPPORT OF RESEARCH 

PROJECT 2020-04 
Final version submitted to the North Carolina Department of 

Transportation 

 
  

      
N.C. DEPT. OF TRANSPORTATION 

COMPLETE TRAINING GUIDE FOR RP2020-04 
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PREPARATION 

Section 1: SITE SELECTION 
The first step is to design a study area that will be surveyed with a LiDAR sensor mounted on a 
DJI Matrice 600 Pro. Here are some tips on how to create an Area of Interest (AOI) in ArcGIS 
Desktop. 

 

1.1: Things You Need to Start 
Software: ArcGIS ArcMap 10.7.1 

Polygon Data: NWI (National Wetland Inventory-2010) 

Polygon Data: NC WAM and NCDOT Wetland Delineation Data (if available) 

Polygon Data: NC Parcel Data 

Coordinate System: “NAD_1983_StatePlane_North_Carolina_FIPS_3200” in meters 

 

1.2: Tips for Selection 
Based on existing wetland delineations (NWI and/or NCWAM data), we want to select places 
where they are the variety of wetland types and its unique patterns.  

Here are more things to consider: 

Take-off/ landing area 

Enough area for drones to take off and land in plus areas for Trimble and other necessary equipment.  

Flight area 

Around 80-100 acres will be adequate. One set of a drone battery (DJI Matrice 600 Pro) can be flown over about 
40 acres. Consider the fieldwork schedule and drone battery. 

Obstacles 

Check for potential objects that might obstruct drone flight such as buildings, power line, and tall trees. 
Surveyors must keep a visual line of the sight on the drone. 

Permission 

Contact landowners for permission to fly and putting out targets. Check the parcel data to see the names of 
them. Be sure to check if there are any gates preventing us to drive. 

Access to Ground Control Points (GCPs) 

Check for the accessibility where you want to put targets. 

Proximity 

Check for the safe flight zone: https://www.dji.com/flysafe/geo-map.  

 

  

https://www.dji.com/flysafe/geo-map
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1.3: Creating AOI in .shp and .kml 
Following to the site selection, you are going to create a flight area in polygon and .kml files. 
Shape file for further analysis and kml file will be uploaded to a DJI GS Pro application for 
automatic drone flight. Here, we will create those in ArcGIS ArcMap. 

1. Creating Polygon Layer in ArcMap 
Here is one of the ways to create a study area in polygon data. Start with a new map in 
ArcMap. Go to Catalog and right click on Geodatabase (create one if you don’t have yet). 
“New” -> “Feature Class”, then a “New Feature Class” window pops up. 

 

 

2. Edit Polygon 
In the process of “New Feature Class”, make sure to put the right coordinate system you 
want. After creating the feature class, right click on the polygon in the “Table of Contents” 
you just created and then, go to “Edit Features” -> “Start Edit” to draw a polygon. When 
done editing, click “Editor” -> “Save Edits” and “Stop Editing”. 
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Use “Layer To KML” tool to export the data into .kmz format (save it outside of a 
geodatabase).  This tool converts a feature or raster layer into a KML file containing a 
translation of Esri geometries and symbology. This file is compressed using ZIP compression, 
has a .kmz extension, and can be read by any KML client including ArcGIS Explorer, 
ArcGlobe, and Google Earth. Converting into .kml allows us to upload the AOI in DJI GS Pro 
application to create automatic UAV flight.  

 

  



4 
 

4. Open KMZ data in Google Earth Pro 
When the export process is done, open the File Explore and click .kmz file to open in Google 
Earth Pro. In Google Earth Pro, go to “File” -> “Save” -> “Save Place As”. Then, save the 
polygon data as .kml. Make sure to save it with the background no fill. 
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1.4: AOI Examples 
1. St. James 

• Date: 5/12/2020 
• Area: 202 acres 
• Take off base:  
• 7 kinds of wetland 
• Residential areas within flight area – hard to get permission for flight/ GCPs 
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2. Topsail High School 
• Date: 6/2/2020 
• Area: 128.45 acres 
• Takeoff landing area: 
• 5 different wetlands 
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3. Surf City 
• Date: 11/6/2020 
• Take off base:  
• 7 wetland types 
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Section 2: FLIGHT MISSION PLANNING 
This step is for creating a flight path of kml in arcmap using a tessellation approach, then 
uploading it to the DJI GS Pro app to create an automated UAV flight. Along with the flight path, 
in the next step we will plan on where to place the Ground Control Points (GCPs). 

2.1: Creating and adding AOI, flight path and GCPs in ArcPro 

Open ArcGIS Pro  - click “Map” (under Blank Templates) -  

a. Name and Save Project to Location of your choice

 

Step 2: Generate Tessellation: 
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 Under Parameters: Click on the *Extent drop down and chose your 

AOI layer (this will change to “As Specified Below”. Shape type = 
Square. Size = 62,500 Square Feet** 
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 Hit the button and it will automatically align over your AOI on 

the map.  
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Step 3: Create Flight Path: 

 Go to “View” (at the top) – Click on   - Folders  - Project Name – 
Right click on .gdb (File GeoDatabase) – New – Feature Class 

 

Click “Finish” 

 
*To upload new feature class right click and click “add to current 
map” 
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 To create a Flight Path for the drone click Edit – Create – Choose the 

Flight Path layer under Create Features  

 

o Make sure snapping is on and place flight path on the 
tessellation inside the AOI that you’ve created making sure not 
to skip a line 

o To make this easier upload a road imagery map to make sure 
not to place over open traffic and roads.  

*The take-off location for the drone does not matter until the DJI App 
portion 
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Step 4: Create Ground Control Points (GCPs): 

 Go to “View” – Catalog – Folders – Right Click Project File – New – 
Shapefile 

o Feature Class Name – GCPs 
o Geometry Type Point 
o Coordinate System same as AOI 
o Hit “RUN” 

 It will automatically add to the project map 
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o Use the Edit tab – Create – Click GCPs 
*Make sure Snapping is on and you lay GCPs along the flight path layer in 
accessible areas* 

• See Section 4 & 5 below for GCP Creation and Trimble Upload.  
 

2.2: Converting Layers to KML through Google Earth Pro 
 

• Convert the GCP layer, Flight Path layer, and AOI layer in tools 
through conversion tools – KML – Layer to KML 

 
• Use the drop-down arrow under *Layer to convert each individual 

layer – Select the file icon in *Output File to the project file to save. 
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• Do this for each layer and hit  after each is uploaded to 
send them to the file of the project. 

*There should be a green complete icon after each 
conversion* 

• Once uploaded zoom in to make sure all layers line up nicely to your 
study area and it is exactly what you want, this includes: 

o GCPs are in a suitable location to be recorded in the field after 
flight 

o Flight Path does not cross over or intersect open traffic or 
major roads 

o AOI is around the correct study area you hope to survey 
 *Note: This AOI can touch major roads because it is not 

what the drone will trace but is what the drone will 
overlap and collect.  

If you are satisfied: Right click each KMZ file and click “Save as” to the same 
file of your KMZ files but change KMZ to KML file at the bottom of save 
menu. 

2.3: Uploading KMZ files to DJI Ground Station Pro (GSP) App through Email 
 

 
• Click on the KML files that you have added to your project folder and 

drag them into an email that you can send to your mobile/tablet 
device. 
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• Click on each file individually and select the ”upload” icon so it can 
be sent to the GSP App.  

o *This will show up in “files” in the GSP app* 

 
• Open DJI GS Pro App on tablet or phone that will control the 

drone during flight in the field – click on “My Missions” (bottom 
right of home screen) – Under the middle tab click materials – 
files – swipe right to uploaded new files brought in from email.  

• Once missions are on the right table called “Map” - Click on the 
“Map” – Click on each file - Swipe left on the drop down tab – Click 
“Pin” on each one of them so they show up on the map.  

• Under the flight layer click the “Create Mission” button – The Map by 
waypoint button should be the only one to appear. Click the 
icon below: 

   

• Now the flight plan you designed in ArcGIS Pro should be under the 
Mission tab with the name “0”. Rename the mission to the area you 
are mapping and modify the mission by clicking on the name and 
hitting “EDIT” at the bottom right next to Fly.   

*This allows the drone to turn at each corner and more of a gentle turn 
rather than a jagged 90.00 corner, thus creating potential errors in data 
collection*  

• Once Flight is complete and you have checked that all parameters are 
correct including:   

o Speed  
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o Height  

o Mission Start & Stop   

Click Save icon on the top left of app.   

 
  



18 
 

Section 3: GCP and CHECK POINTS GENERATION 
Ground Control Points (GCPs) are used to align collected UAS data to known GNSS locations to 
improve the accuracy of the data in post-processing. Cardboard targets will be placed to 
measure GCPs in a RTK system. In terms of acquiring LiDAR data, it is recommended to place 
GCP targets right below the flight path to get the best end results.  

3.1: Tips for Layout 
Ideally GCPs on each end of the flight path 

Minimum of 5-7 points 

Check out for the accessibility and the owners 

Spread out evenly within the AOI 

 

3.2: Target Location 
Target location should be directly below the flight path of drone to have the least error when 
processing the LiDAR data. As described above, the targets should be placed as much as possible 
on flight paths as shown in the image below. 
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If not possible due to the accessibility, you can use less targets like the image below. 

 

Once the location of target is decided, add XY coordinate system and export it into a csv file to 
import into a Trimble unit. Also, you may want to check with property owners to get permission 
for your target to put down. 
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3.3: Things You Need to Start 
Line Data: Flight path of UVA 

Polygon Data: Area of Interest (AOI) 

Coordinate System: “NAD_1983_StatePlane_North_Carolina_FIPS_3200” in meters 

 

3.4: Generation of checkpoints 
1. Open ArcMap and Add Data 
Open ArcMap and add AOI and flight path data.  

 
2. Create point feature 
Using a “Create Feature Class” to create an empty point data 
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3. Edit Point Feature 
Go to “Edit Features” -> “Start Edit” to start placing points where you plant to place targets. 
When done editing, click “Editor” -> “Save Edits” and “Stop Editing”. 

]
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4. Add XY Coordinate 
Use “Add XY Coordinates” to add XY coordinates. Make sure the points have the correct 
coordinate system: “NAD_1983_StatePlane_North_Carolina_FIPS_3200” in meters.  

 

 

Use “Table to Table” to make this attribute table into CSV file. Make sure the data contains 
the object ID, XY coordinate system, and reference habitat type (ATTRIBUTE) at least. Save 
this outside of GDB as “---.csv”. These reference points are for Trimble to recognize. The 
column order has to be: X – Y – Object ID – Code 
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Section 4: GENERATION OF HABITAT POINTS (optional) 
Here is one of the ways of how you can create habitat reference points in ArcGIS. Habitat points 
can be collected in order to help with final data classifications. We are going to show two 
different methods to create 15 random points (+ 50 points for only non-wetland area) for each 
habitat class based on NWI. Read "Create Random Points" and “Create Spatially Balanced 
Points” tools in Arc Help for more information. 
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Polygon Data: Area of Interest (AOI) 

Polygon Data: NWI (National Wetland Inventory-2010) 

Polygon Data: NC WAM and Wet Master (if available) 

Coordinate System: “NAD_1983_StatePlane_North_Carolina_FIPS_3200” in meters 
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4.2: Generation of Habitat Points 
6. Open ArcMap and Add Data 
Open ArcMap and add AOI and NWI data. Change the symbology of NWI by going to Layer 
Properties. Click Symbology -> Categories -> ATTRIBUTE -> Add All Values. Always check the 
coordinate system as “NAD_1983_StatePlane_North_Carolina_FIPS_3200” in meters. If it’s 
not the right coordinate system, use “Project” tool to convert. 

    

 

 

Use “Clip” (Analysis) to extract the NWI polygon that overlay the AOI. Use “Union” to union 
the NWI and study area polygon to fill in the non-wetland area. “Dissolve” the polygon by 
attribute. Open the attribute table and type “NonWetland” for the black column in 
ATTRIBUTE.  
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8. Create Random Points (CRP) 
As it was mentioned above, for non-wetland area 50 random points are going to be 
generated as this area includes more than one landcover class (built, upland grass, upland 
shrub, upland forest, open water, and other). Select only NonWetland polygon and run 
“Create Random Points” tool to generate 50 points. Then, select all wetland polygons to 
create 15 points for each of the class. Change the Linear unit accordingly. 
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9. Assess the Results 
Look at the results along with the most recent imagery/map of the site and figure out if you 
can walk to the points. (Although if it is in dense forest, you would not collect the point data 
because the tree cover prevents the satellite network to come in) If so, skip to 6. If not, go 
to step 5 for the Spatially Balanced Points approach. 

For example, you would not get to collect all points in the yellow area, so it is worth trying 
the Spatially Balanced Points approach. 
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10. Spatially Balanced Points Approach 
Here, we are starting over and create a weighted random sample using the Spatially 
Balanced Points approach where you increase the weight on access areas.  

a. Create a “Euclidean Distance” Raster based on a Line 
Create a line feature where it covers road and accessible areas and run a “Euclidean Distance” 
tool to create raster. In Environment settings, define the processing extent and raster analysis as 
study area (10 feet or 3 meters). 
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b. Raster Calculator 
Use “Raster calculator” tool to make the range from 0 – 1 (raster / max value). Use 
“Raster Calculator” tool again to inverse the value. E.g. I -> 0, 0 -> 1 
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c. Clip and Create Spatial Balanced Point (SBP) 
Clip each of habitat types and run a “create spatially balanced point” for each of them. 
You can use this “Separate by Attribute” tool to break up the habitat polygon into each. 
Using batch would be a great way to save time. 
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11. Merge and Spatial Joint 
Merge all the generated points (by SBP or CRP). Use spatial joint to extract attribute values 
to each point so that each point has a wetland code. 
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12. Add XY Coordinate and Convert to CSV file 
Use “Add XY Coordinates” to add XY coordinates. Make sure the points have the correct 
coordinate system: “NAD_1983_StatePlane_North_Carolina_FIPS_3200” in meters. Use 
“Table to Table” to make this attribute table into CSV file. Make sure the data contains the 
object ID, XY coordinate system, and reference habitat type (ATTRIBUTE) at least. Save this 
outside of GDB as “---.csv”. These reference points are for Trimble to recognize. 

 

 

Edit the CSV file. Make sure to get rid of the headers and other unnecessary data. Order has 
to be: X – Y – Object ID – Habitat type 
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Section 5: IMPORT DATA to TRIMBLE ACCESS 
Here is to show how to import data to Trimble unit. The Trimble data controller uses a single 
shapefile (.shp) as a background image. Bringing in .shp files will make fieldwork much easier. 
Here, we will use R10 unit as an example. Depending on the unit, the appearance might look 
different. To find out more information, go to the additional files and read 
“TrimbleAccess_Projects_and_Jobs”.  

5.1: Things You Need to Start 
Trimble Units for GCPs and Habitat Points  

(We have 2 units R8 – TSC3, and R10 – TSC7) 

In USB Drive 

CSV File: GCPs Data 

CSV File: Habitat Data 

Point Shape File: Habitat data 

Point Shape File: GCPs Data 

Point Line: Flight Path 

Polygon Shape File: NWI of AOI 

Shape File: NC County Boundary 

*Shape files can be obtained when you save the layer in ArcMap outside of geodatabase 
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5.2: Data Import (R10) 
1. Open Trimble Access App 
Turn on the Trimble unit and open Trimble Access. Then, this window (this might be different 
depending on the version) should pop up. Click “New” to create a project, which is a folder for 
grouping Trimble Access jobs and the files used by those jobs. Here, I already have created 
project named “DoT_works”. 

 

 

After creating a project, the “DoT_works” file should be created under here: 
“C:\ProgramData\Trimble\Trimble Data\Projects”. In “DoT_works”, create a site name folder 
like “BNP”.  Inside this, paste all the necessary data that you have created for fieldwork. 
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3. Create a job 
Come back and open the “DoT_work” project in Trimble Access and hit “New” to create a job. 
Fill out in a “New job” window. Select “Last used job” for template if you wish to inherit the 
properties from previously used project. 

 

 

    

Then we hit the import button.  
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4. Job Setting 
Clicking “coordinate system” under “Properties” will lead you to a “Select coordinate system” 
window. Here, the coordinate system should be the same as that of .shp files you imported.  

Start entering “Active map” where you connect to the .shp files. In “Active map” window, hit 
“Browse” to select .shp files you wish to bring in. Once you bring all the data to Active map, 
make sure to check the boxes right next to the names.  

When all the setting is done, choose “Accept” and the map with features will be created. 
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5. Import CSV Files 
From the job page – select Import. For “File name”, use the folder icon to navigate to your 
project file location and select the .csv file (GCPs and habitat point csv files). Click “Accept” to 
process with the import. You should receive a Transfer Complete message. The imported points 
can be reviewed using the point properties. Open job -> Select Job data -> select Point Manager. 

That is all for importing data. The interactive map with features should be projected. 
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Section 6: EQUIPTMENT CHARGE AND CARE 
Here is how to take care of equipment UNCW Research Team uses for the LiDAR data collection. 
This includes charging/ discharging, and field work checklist. 

6.1: Charging List 

 

 

 

 

 

LiDAR System 

DJI Matrice Battery (18) and 
Controller 

  

iPad 

 

Quanergy sensor LiPo Battery 
(4) 
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eBee System 

Charge/discharge LiPo 
batteries (4) 

Full (100%) – before flight 

Storage (70%) – when stored  

Computer 

 

Trimble System 

MiFi (2) 

 

Rover Battery 

(2 sets * n Trimbles) 

 

Tablets (* n Trimbles) 

   

Additional Tech 

Walkie-talkies (2) 
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6.2: Charge DJI Matrice Batteries and Controller  

1. Battery and Controller 
Take out a battery box from the bottom of DJI, controller, and battery codes. 

 
2. Charge Equipment 
Set it up like the photo below to start charging. When charging, the batteries’ lights will 
flash. When fully charged, they stop flashing. Push the button to see all four bars flash to 
make sure it is all charged. It will take about 2 hours for 6 batteries to be 100% charged. 
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6.3: Charge Quanergy Sensor Battery 
1. Lipo Battery  
There are 2 sets of 2 LiPo batteries (4 total). They should be always in storage charged (70%) 
except before the flight in fully charged (100%). For more info about lipo battery 
(https://www.instructables.com/Lithium-Polymer-Etiquette/ ) 

 

 
2. Measure Voltage 
Before charging, measure the voltage with this small device. Use the balancing cable (white 
one) with the arrows facing down. When it shows 12.6, it is fully charged. Make sure you put 
it on the left side with the correct face up. 

    

 

 
 

3. Equipment 

https://www.instructables.com/Lithium-Polymer-Etiquette/
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Use this blue charger and code to charge the LiPo batteries. 

 

 
4. Plug in Balancing Cable 
Plug in the white balancing cable first and the yellow power cable next. Put the balancing 
cable in with arrows facing up in a 3 cells space.  

 

 

5. Start charging 
Hold a start button to check the battery and press start again to confirm charging. It beeps 
when fully charged.  This is what it looks like when fully charged. Push the stop button twice 
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to get back to the main menu. Unplug the yellow cable first, then the white cable next. 

 

 

6.4: Charge eBee Lipo Battery 
1. Charge Types 
There are a few different types of charge for eBee charger. Know when the next flight will 
be and decide which to use. 

a) Full (100%): fully charge before a flight 
b) Storage (70%): set it storage charge when you do not plan to fly for a while 

 
2. Plug in 
After plug in, connect the balancing cable to the female with the correct way first, and the 
black powering cable next.  

  

 
3. Setting Up 
Click down on the wheel to select: eBee Plus > full or storage charge. Discharging takes 
much more time than charging. One thing to know is the voltage. When it is fully charged, it 
should be close to 12 V. They will beep once fully charged. 
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6.5: Charge Trimble System 
1. Charge MiFi 
Charge like a normal phone. 

 

 
2. Rover Batteries 
Depending on the version of Trimble, the battery may look different. The way to charge 
them is the same. 
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6.6: Equipment Checklist (EXAMPLE) 
Pilot-in-command:   Check-out (      / / ) Check-in (      / / ) 
   

senseFly eBee Plus 
eBee drone 
cameras: SODA, Sequoia, ThermoMap, Zenmuse 
batteries (4) 
smart charger 
regular charger 
radio modem 
extra skid plate 
extra wings 
repair kit (includes extra props, rubber bands, & tape etc) 
registration + GCPs + CHECK POINTS 

  

  

  

  

  

  

  

  

  

  

  

   

Mavic Pro drones 
Mavic Pro Platinum drone 
Mavic Pro Platinum controller & cords 
Mavic Pro drone (oldest) 
Mavic Pro controller & cords 
batteries (5) 
charger 
extra props 
registration 

  

  

  

  

  

  

  

  

  

   

Mavic Pro drones 
Mavic 2 Pro drone (orange) 
Mavic 2 Pro controller & cords (orange) 
batteries (3) (orange) 
Mavic 2 Pro drone (purple) 
Mavic 2 Pro controller & cords (purple) 
batteries (3) (purple) 
Smart charger for Mavic 2 Pros 
extra props 
registration 

  
  

  

  

  

  

  

  

  

  

   

DJI Matrice 600 Pro & Quanergy LiDAR: 3 BOXES TOTAL 
Matrice hexacopter drone (big box) 
Matrice controller & cords + Mini iPAD! + charger (big box) 
Box of 3 sets of 6 batteries: 18 total (heavy, small box) 
Quanergy M8 LiDAR (second small box) 
Quanergy M8 battery charger and 2 sets of Lipo batteries (4 total) 
Extra props 
registration 

  
  

  

  

  

  

  

  

   

Additional tech & equipment 
walkie-talkies (2) 
walkie-talkie charger 
LAPTOP, charger, and mouse 
memory cards (one for each drone plus one extra) 
mini SD card converter 
SD-USB adaptor 
power inverter 
phone chargers for field 
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Documents 
FAA Pilot cards 
flight plans, maps, etc 
RTK SYSTEM AND ADDTL GPS 
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FIELDWORK DAY 

Section 7: TRIMBLE – HOW TO CREATE AND BEGIN A STATIC 
SURVEY 
A static survey collects GNSS (Global Navigation Satellite System) to improve the LiDAR data in 
the post-processing.  

Components 

Trimble Set (quick release adopter, mount, connection cable,  

Trimble Unit 

Tripods 

 

7.1: Select a Base Station 
For good performance, place the GNSS receivers in a protected and secure location. Do not set 
up the base station directly beneath or close to overhead power lines or electrical generation 
facilities. The electromagnetic fields associated with these utilities can interfere with GNSS 
receiver operation. For more information, visit here: R10 GNSS - User Guide (pg. 36 - )  

 

7.2: Trimble Setup 
One of the common ways to set up the base station is to use a tripod.  

 

 

  

https://www.trimble.com/ls_receiverhelp/v5.11/en/r10%20userguide.pdf
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1. Attach Adopter/ Rover to Pole  
Mount the quick release adapter onto the height extension pole with measurement lever. 
Attach the GNSS receiver to the quick release adapter. 

    

 

 

2. Attach the Tripod Leg 
Attach the tripod legs onto the pole, and level the bubble onto the center.  

 

3. Attach Mount 
Attach the mount to the pole.  
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4. Connect Epoch Cable 
For static survey, you want to connect GNSS via a cable. Connect the epoch cable to the 
rover and the tablet. Make sure to connect the cable to the rover matching with the red 
marks. 

  

 

7.3 How to create a static survey using a Trimble RTK system – R8 & R10  
R8 intructions 
Creating a new static survey on the TSC3 handheld model for R8 Trimble requires a new project 
folder to be created in the static style.  

1. Open Trimble Access Menu  Click Settings  Survey Styles  Create New (Add Name 
and Style Type- GNSS)  Accept 

 
For the next steps, “Rover options” and “Base options” parameters will need to be defined for 
survey style to function.  

 
 

2. Rover options  Define Parameters  Accept   
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3. Base Options  Define Parameters  Accept  Store  
 
 

 

 

 

 

 

 

 

R10 instructions  
Creating a new static survey on the TSC7 handheld model for R10 Trimble requires a new project 
folder to be created. In the new project folder, jobs can be created with outlined parameters to 
start a static survey. The general workflow to create a project folder is as follows:  
 

1. Open Trimble Access and navigate to projects menu 
 

2. Tap “New” on the top left under the three horizontal bar menu button  
Add in project folder details  Create New Job  Tap Coordinate System  Fill in 
associated parameters (example below)  Job created and ready to use in static survey  

 
 
7.4: How to Start Static Survey – R8 
To get the best accuracy of GNSS data, it is recommended to run the static survey at least for 20 
minutes before you start your UAV flight. 

1. Open Trimble Access 
Open “Trimble Access” in your tablet. Select: General survey -> open job -> Quan_Rinex -> 
select measure -> drone static -> measure points   

 



54 
 

2. Setups for Drone Statics 
You will be required to fill in the survey settings here: 

a. Point name: “Topsail”  
b. Method: FastStatic point  
c. Antenna height: 2 m 
d. Measured to: bottom of antenna mount 

Then, hit to measure.  

 

 

 

 

 

 

 

7.5: How to Start Static Survey – R10 
1. Open Trimble Access 
Open “Trimble Access” in your tablet. Open “QUAN_RINEX” project. Create a new job by clicking 
the “New” tab. 
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2. New Job 
In the New Job setting, put the project name, and correct coordinate system.
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3. Start Your Survey 
Once you have created your job, it is ready to start your static survey. Navigate to: “Measure” -> 
“STAT2” -> “Start Base Receiver”. “Start Base” window will pop up. 

 

For “Start Base”,   

a. Point name: “CampusTest”  

b. Measured to: Bottom of quick release  

c. Antenna height: 2 m  

Press enter. You can ignore the warning sign, then start.  
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7.5: Troubleshooting 
Error: Trying to connect via Cable 

For static survey, Trimble units should connect to GNSS via cable not Bluetooth. If this error 
pops up, you need to go to a Bluetooth setting to change your settings. 

R10 (Settings -> Connect -> Bluetooth) 

Connect to GNSS -> Cable 

 

R8 (Settings -> Connect -> Bluetooth) 
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Section 8: THE QUANERGY M8 LiDAR SYSTEM 
Here is how to set up the Quanergy System on the field after the LiDAR drone assembly. 

Before the System Setup 

• Assemble a drone 
• Have started Trimble static over 20 mins 

8.1: Quanergy System Setup 
1. Power System 
Connect the two red/black power cables to the LiDAR system. They all go in one way. Press 
the button on the side of Quanergy to start up the LiDAR system. It will take 45-60 seconds 
to Hot Spot to be ready. 
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2. Hot Spot 
In the tablet, exit all the applications and switch from WiFi to HotSpot.  

Hotspot name: AQB2-19    

PWD: scanlook 

Go to your browser in your iPad and type in the IP address “192.168.0.1”. Add to your 
favorites. It will take you to a setting page. 
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3. System Settings 
Go to the settings to make sure all the measurements are correct. 

  

Make sure that INS script on the bottom of the page is set for “back of UAV snoopy 2-IL”. Set 
for Antenna-A-Lever Arms as the same as the above, then hit save. 

Go to Snoopy tab to change the project name – no space!! (ex. Test1) 

Then we are ready to start! Hit Snoopy INS start. Wait till it turns green about 30 seconds. 
What they are doing is the drone is tracking satellite signals such as GPS or GLONASS and 
getting IMU data 

 

Press start on Quanergy to begin scanning. When it turns green, all the Lidar system set up is 
done and the mission for data collection can begin. 
 

4. Shutting-down the system 
When the flight is done, the system needs to be carefully shutdown. Go back to the 
webpage, you start stopping from the bottom (Quanergy -> Snoopy INS). Wait for it to turn 
it to pink, and then stop the IMU. Then, go to the top of the page to hit” shutdown”. When 
the website is shutdown, the hot spot is also going to disappear. 
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Section 9: TRIMBLE – POINT SURVEY 
Point survey will be used to measure the coordinate systems of GCP targets and habitat points. 
Those points will be used for georeferencing, accuracy assessment, and classification analysis. 

9.1: Things You Need to Start 
Trimble Box (rover etc.) 

Trimble Unit (R10, R8) 

o CSV File: Habitat Data 

o CSV File: GCPs Data 

o Point Shape File: Habitat data 

o Point Shape File: GCPs Data 

o Line Data: Lines of accessible areas (if needed) 

o Polygon Shape File: NWI of AOI 

o Shape File: NC County Boundary 

Tripod (only for GCP collection) 

MiFi 

 

9.2: Trimble Setup 
The setup is very similar to the static survey except for not using a cable. 

1. Attach Adopter/ Rover to Pole  
Mount the quick release adapter onto the height extension pole with measurement lever. 
Attach the GNSS receiver to the quick release adapter. No need to use tripod necessarily 
unless you do a GCP collection. 
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2. Attach Mount and Legs 
Attach the mount and legs to the pole. 

 

 

9.3: How to Start a Point Survey – R8 
1. Turn on MiFi 
Turn on your MiFi (pocket WiFi) to enable the Trimble unit to connect to rover via Bluetooth 

 

2. Connect Table to MiFi  
Open your Trimble tablet and navigate to Setting -> WiFi Connection to make sure the unit it 
connected to your MiFi 

 

3. Open Trimble Access 
Open “Trimble Access” in your tablet. Open your point collection job you have already 
created. Select DoT_work -> your job. 

 

4. Setups for Topo 
To start your survey, select Measure, then: 

a. Measure: RTN2015 
b. GNSS contacts: MiFi 
c. Select data source: VRS_CMRx 
d. Method 

1. Habitat points: Topo point (3sec)  
2. GCPs: Observed control point (3mins)  
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9.4: How to Start a Point Survey – R10 
1. Turn on MiFi 
Turn on your MiFi (pocket WiFi) to enable the Trimble unit to connect with rover via 
Bluetooth 

2. Connect Table to MiFi  
Open your Trimble tablet and connect your MiFi to this tablet.  

 

 

3. Turn on Rover 
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4. Open Trimble Access 
Open “Trimble Access” in your tablet. Open your point collection job you have already 
created. Select DoT_work -> your job. Then, go to Measure -> NCRTN_19 - > Measure 
Points. Then, select:  

a. Select survey style:  NCRT_19   
b. GNSS contacts:  NCRTN 
c. Select Data source: VRS_CMRx  
d. Method 

a. Habitat points: Topo point (3sec)  
b. GCPs and check points: Observed control point (3mins 
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9.5: Tips for Point Collection 
Off-Set Collection 

Reference video: Tuesday Tip - GPS offsets with Trimble Access. During your collection, 
sometimes topo points can be in the deep forest where access is limited. An off-set tool will 
enable you to collect a point remotely. 

During your survey, the first thing you will do to do off-set is to go to Cogo. Cogo -> Compute 
Point 

In the compute point window: 

 

- Point name: name the point of where you want to collect remotely 
- Code: PP – power pole (for example) 
- Method: Bearing and distance 
- Start Point: Measure 

Measure points 

- Point name: where you are 
- Code: OS (Off-set) 
- Method: Topo 
- Height: 2m 
- Measure to: Bottom of quick release 

https://www.youtube.com/watch?v=GOsbOVtwbxI&t=185s
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Measure Codes 

If you have set up the measure codes, it will make your survey easier and quick. It is possible to 
survey by picking from a defined selection of codes as shown below instead of picking codes 
from a list or manually entering them, as in the Measure Points screen. Defined codes can be no 
more than 25. This method is particularly useful if you are only using a small number of codes on 
a regular basis, measuring string features, or need to constrain the number of codes used on a 
series of cross sections for example. 

1. Open Job 
Have MiFi and R10 Rover ready and go outside. Open the job. Go to Menu -> Measure -> 
NCRTN_19 -> Measure codes -> GNSS contacts: NCRTN -> Select Data source: VRS_CMRx 

The first time this screen is used you will need to press the Add group button (+) to create a 
screen of blank buttons. 
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2. Assign Code 
The default setting has 9 (3*3) code layout. To assign a code to a button, tap and hold on a 
button and then release. Enter the code required. String numbers can be attached to codes 
by highlighting the button required and using the – and + keys at the base of the screen. 

 

3. Change Code Layer 
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If you wish to change the code button layout on the screen, go to “Measure code options”. 
Here you can play with hose settings if you want. 

 

4. Measure Point 
To measure a code point, just tap the button required. After tapping it, this measure points 
window will show-up. 
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POST-FIELDWORK 

Section 10: Download FIELDWORK DATA 
The first thing you do following field work data collection is to take off the data and save it to 
your local drive somewhere you can pre-process. 

10.1: DJI Matrice 600 Pro– Quanergy M8 LiDAR sensor and Zenmuse X5 RGB 
camera (flown concurrently) 
Following your fieldwork, download the LiDAR data from the Matrice with the USB stick (AQB2-
19-0635-05) and Zenmuse with a micro SD 

1. Download Quanergy Data  
Open the UBS and open your project: F:\StJames05122020 

 

2. Copy and Paste 
Copy all the files to the DoT Server: S:\DoT_Analysis\RAW_DATA\StJames05122020\Matrice

 

3. Download Zenmuse Data 
Zenmuse has a micro SD card inserted on its side. 
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10.2: eBee – sequoia (Multispectral), SODA (RGB), thermal map (Thermal) 
If you fly eBee with multispectral, RGB, and thermal, there will be a memory card for each 
sensor. A SD card reader will be stored in an eBee box. Download the data of the correct data to 
the server:  

From: F:\DICM\EP- EP-01-22439_0128 

To: S:\DoT_Analysis\RAW_DATA\StJames05122020\eBee\EP-01-22439_0128 

A multispectral sensor has 5 lenses for red, green, red edge, infrared, and RGB, and it takes 5 
shots of photo at a time. So, there is going to be a series of 5 photos for each shot. 

 
10.3: Exporting Trimble Data– R8, R10 

1. Static Data 
Turn on a Trimble unit and find a static data in file explore. The data is stored in a 
“QUAN_RINEX” folder. Copy a job and .t02 file over to the server.  
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2. RTK Data (GCPs and Habitat Pts) 
To export point data in excel file from Trimble, the first step is to select DoT_works -> BNP 
(your job). Tap Export. 

 

Select the file format and click on the file mart next to File name to select where you will 
save this data (in a USB stick). 
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Select your point format. “All points” is recommended. 

 

Also to be exported is a .job data. This data contains all info about the survey, such as time 
stamps and coordinate systems. Go to DoT_works and copy and paste “BNP.job” to DoT 
server. 
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Section  11: LiDAR PROCESSING PREP 
Pre-processing LiDAR is a complex, multi-step process. The software programs required include: 
Inertial Explorer, Scanlook PC, Cloud Compare and Global Mapper, however there are few things 
to do before the actual processing the data. The process is very briefly outlined below and 
discussed sequentially below.  

 

11.1: File Organization 
1. Create Folders 
In local drive (like Desktop), create a folder “SiteName”. Copy “LiDAR”, “Snoopy” and Scanlook.xml 
and paste them in the new folder “SiteName”. 
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2. Create Empty Folders 
In “SiteName”, create empty folder named “INS” and “BASE” folders.  

 

 
3. In BASE: Bring the Static Data (….t02) from the “TRIMBLES”-> “StaticData” file.  

 

 
4. Let’s look inside INS, LiDAR, and Snoopy files. 

a. In INS: empty now 
b. In LiDAR: 

 
c. In Snoopy: 

 
 

11.2: AirData Flight Path Generation 
This is the website where you can upload your flight log to see the detailed flight information. 
There information will be helpful when generating a point cloud in Scanlook PC. 

AIRDATRA: https://airdata.com/ 

https://airdata.com/
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Username: am3303@uncw.edu 

Password: am3303@uncw.edu 

Airdata: How to upload flight logs: https://app.airdata.com/dji-gs-
pro#:~:text=Once%20your%20flight%20logs%20are,to%20flights%22%20to%20view%20them.  

 

11.3: Rinex Conversion 
After downloading static data as a T02 file from Trimble, you need to convert the file to Rinex 
format. The RINEX converter is a free software 

1. Start Convert to Rinex  
(Go to here for more info: https://www.trimble.com/support_trl.aspx?Nav=Collection-
40773&pt=Trimble%20RINEX). Go to File -> Open. Then select .t02 file. 

 

 

Then, software scan starts. 

mailto:am3303@uncw.edu
mailto:am3303@uncw.edu
https://app.airdata.com/dji-gs-pro#:%7E:text=Once%20your%20flight%20logs%20are,to%20flights%22%20to%20view%20them
https://app.airdata.com/dji-gs-pro#:%7E:text=Once%20your%20flight%20logs%20are,to%20flights%22%20to%20view%20them
https://www.trimble.com/support_trl.aspx?Nav=Collection-40773&pt=Trimble%20RINEX
https://www.trimble.com/support_trl.aspx?Nav=Collection-40773&pt=Trimble%20RINEX
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2. Convert to Rinex 
When scanning is completed, go to File -> Convert Files. Then Rinex file(.o,n,g) is created 
from a .t02 file. 

- .**o files: observation data files, contain satellites position data. 
- .**n files: navigation data files, contain GPS ephemeris data. 
- .**g files: navigation data files, contain GLONASS (Russian) ephemeris data. 
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11.4: OPUS SOLUTION 
OPUS (NOAA's Online Positioning User Service) provides free access to high-accuracy National 
Spatial Reference System (NSRS) coordinates. OPUS uses software which computes coordinates 
using the NOAA CORS Network (NCN). The OPUS result will be used in the LiDAR processing.  

1. Go to OPUS websites 
To use OPUS, simply upload a GPS data file (collected with a survey-grade GPS receiver) to 
the OPUS upload page. Your computed NSRS position will be emailed to you. If you choose, 
your position can also be shared publicly on the NGS website. 

OPUS: https://geodesy.noaa.gov/OPUS/ 

Data file: .20o (converted from Trimble) 

Antenna: “TRMR8_GNSS NONE” or your Static Trimble Unit 

Antenna Height: 2 meters 

Email: Type your email and  

Either “Upload to Rapid Static” or “Upload Static” depending on the survey time

 

 

https://geodesy.noaa.gov/OPUS/
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2. OPUS Results in Email 
You will get an OPUS result by Email. Copy and paste it to a text file to keep it as a record. 
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3. Error 
Sometimes the OPUS email comes back with error message like the image below. 

 

It failed because there were two static surveys recorded in the same name. In River Road, the wind 
knocked down Trimble during the first static survey. We started it over in a stable place but in the 
different place from the first survey. That is why the email says, “data taken from more than one 
location”.  

Go back to 20o file to fix this problem. Open that rinex file up in notepad and scroll down, probably 
two pages, and follow those directions that OPUS is giving you and remove the data between the 
bottom of the "big" header/notes and where you actually cranked it up with the DC which should, 
depending on how long you let it sit there, be a page or two, maybe three. Delete that area and 
resubmit.  https://rplstoday.com/community/software-cad-mapping/rinex-file-question/). 

  

https://rplstoday.com/community/software-cad-mapping/rinex-file-question/
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4. Delete the blue area and re-submit it to the OPUS to see if this wo 
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Section 12: LiDAR PROCESSING STEP 1 – INERTIAL EXPLORER 
This guide will provide you with step-by-step instructions on how to create a trajectory for your 
specific dataset using Inertial Explore. 

12.1: Inertial Explore: Project Setting 
Open Inertial Explorer -> File -> New Project -> Project Wizard -> Next. 

1. Under “INS”, name your project. Click Next. 

 

 
2. For GNSS:  Snoopy -> .gps file 

For IMU Data: Snoopy -> .imr file  (if you have) 

 

Click Next (*A processing window will pop up for about 15 seconds) 



84 
 

 

 

3. On the “Remote (Rover) Antenna Height” window, do not alter any of the settings as 
the antenna height offsets were accounted for during the flight 
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4. Choose “I would like to add base station data” 
Under “Precise Files” choose the “Download precise files” option 

 

 

5. On the “Base (Master) Station” window, click on the “Add Station from File”, and then 
click next. 

 

 

 

 

6. On the “Base (Master) Station Data From a File”, select Browser and navigate to the 
BASE folder and choose the 20o file. This file will be translated to be gpb file. 
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7. Error window will pop-up. Click OK. 

 

 

8. For “Base (Master) Station Information” 
• Coordinate: correct the small decimals, change datum, Elip height, epoch. Go look 

at the OPUS text to find out. 
• Antenna profile:  select “TRMR8_GNSS” 
• Measured to: ARP (Antenna Reference Point) 
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Next -> Next -> Finish. Now project is 
created. 
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12.2: Process GNSS 
The trajectory is now created. The line shows the flight path. 

1. Click Process -> Process GNSS 

 

If you like to clip off some flight path by time, make sure to have the start and end time 
by clicking on the point. 
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Start: 494007.000 – 17:13:27 
End: 494679.000 – 17:24:39 
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2. Click on the “Process” -> “Process GNSS”  
• Processing Method: Differential GNSS 
• Processing Direction: Both 
• Profile: GNSS UAV 
• Datum: NAD83(2011) 

Select the datum in which you need your trajectory to be in. Advanced for selecting 
certain time frame. 

 

  

Start: 494007.000 – 17:13:27 
End: 494679.000 – 17:24:39 
The warning might come up, but you can hit continue.  
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3. Check the accuracy by selecting Plot Results -> Estimated Position Accuracy 
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12.3: Process Tightly Coupled 
1. Click on the “Process” -> “Tightly Coupled”  

• Click Process -> Tightly Coupled.  
• Profile: SPAN UAV (STIM300) 
• Datum: NAD83(2011) 

 

The GNSS trajectory is first processed and the resulting time-stamped position and 
velocity updates are passed to the loosely coupled processor. In this two-stage mode, 
users can extensively QC their processed GNSS-trajectory prior to LC processing. 

Process (Tightly Coupled) - In this mode, GNSS and INS data are processed 
simultaneously. This mode is generally favored in challenging GNSS conditions as it 
maximizes GNSS availability, as phase updates (which form the distance and direction 
traveled between epochs) can be applied where as few as two satellites are available. 
This serves to significantly limit inertial error growth in the absence of a full GNSS 
position update. 

This might take a while. Now trajectory has been processed. Now trajectory has been 
processed. 
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2. Run the estimated accuracy assessment again to see how this process improved. 

 

12.4: Export Trajectory 
Next step is to export the project. Go to Output -> Export Wizard 
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98 
 

 



99 
 

 

Done! 
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Section 13: LiDAR PROCESSING STEP 2 – Scanlook PC 
This guide will provide you with step-by-step instructions on operating ScanLook PC which is 
needed for point cloud generation. Once successfully completed, you will be able to output 
point clouds viewed and manipulated in third party software.  

13.1: Project Setting 
1. Search and open “scanlook pc point cloud creation”. 

 
 

2. Project Settings 
For the “Project Folder”, place the data path of the LiDAR main folder (should be 
“SiteName_LiDAR” in the local drive).  
In this example, select “C:\Users\mapesk\Desktop\CastleBayGolf”, which file has all the 
“Inertial Explorer” data. After you selected that main project folder, then the rest of 
folders should ALL AUTOMATICALLY FILE IN from your main project folder. THE GEOREF 
folder needs to be red as it needs to be created. You can edit the folder connections if 
they did not automatically file in. 

Sensor: Quanergy M8, 1 – Primary 
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3. Filter Settings (Units Meters)/ Distance Filters 
Check: Spatial Filter and Rate of Turn (Deg) as 10 

 
Air Data for more info about flight mission 

 

Here are the explanation of each parameters and its example numbers if you fly at 
175ft. 

• Max Depth: 175ft (53.3m) 
o Discards all points more than the entered value below the scanner. It is 

not an absolute depth, but it is relative to the scanner itself. 
o If we fly at 150ft, the max depth needs to be bigger, but not too big. 

• Max Height: 0.01ft (0.01m) 
o It won’t process above this height. So, in this case, it won’t take any 

point at more than 0.01 ft above the sensor. 
• Max LHS / RHS (Right Hand Side): 150 ft (45.7m) 

o These filters discard all points beyond the range set  
o This is to match the distance between the flight lines. 

• Min Distance: 12 ft (3.66m) 
o Set filters to discard all points within the Min Distance  

• Max Distance: 250 ft (76.2m) 
o Set filters to discard all points outside the Max Dist. 
o think hypotenuse resolving the distance between flight lines and sensor 

• Stationary Distance: No Select unless mobile mapping 
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o  Sets the minimum distance the vehicle must travel between revolutions 
of the selected sensor to be included in the output data. If the vehicle 
does not travel enough then those points in that revolution of the 
scanner are discarded. 
 

4. Output Settings 
• Format: LAS 1.2 

Select the output format in which you want to generate depending on which 3rd 
party point cloud post-processing program you use you may need to generate 
one. 

• Check: LAZ and 1 Folder 

 
 

5. Bore Sight Settings 
Enter in the Bore Sight Values that will be given to you provided from LidarUSA.  
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13.2: Graphics 
1. The “Graphics” button on the bottom of the window, will show you the trajectory. In 

this menu you can select the parts which you would like to see a gridded display. Right 
click your mouse then in this menu go down to “Boundary” then click, “Start Boundary”. 
You might want to cut out the corner turns to reduce errors. Exit the graphic window 
when done. 
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Now, data selected in the previous step will show up in the selected menu. 

 
13.3: Convert 

1. If you click, “Convert” the selected data (or the entire project) depending on what you 
want to convert for your project will be the file format you selected. To find these 
generated files, click in the “Lidar” folder of your project, then click in the “GeoRef 
folder”. 
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Section 14: DATA PROCESSING IN GLOBAL MAPPER –ACCURACY 
ASSESSMENT 
This guide will provide you with step-by-step instructions on operating Global Mapper which is 
needed to assess vertical accuracy. Once successfully completed, you will be able to see the 
total RMSE. 

14.1: Check Points 
On the field, you will collect two kinds of points: check points and control points. Control points 
measured on each target will be used to georeference the LiDAR data. Check points could be 
measured on the target or random place with high accuracy and will be used to assess the 
vertical accuracy of the unconstrained point clouds here. 

Creating a check point csv file out of the Trimble data. Format like the images below. 

 

Name x y z Habitat Check/ Control 

gcp_0 770582.512 129466.932 9.994 woody field Control 

gcp_1 770546.498 129398.302 10 Woody field Control 

gcp_2 770549.528 129319.607 10.33 Woody field Control 

gcp_3 770506.234 129254.739 10.758 Woody field Control 

gcp_6 770721.455 129042.01 11.181 Woody field Control 

gcp_7 770741.664 128958.522 9.969 woody field Control 

gcp_8 770732.892 128883.926 10.918 woody field Control 

gcp_9 770726.727 128806.342 8.599 woody field Control 

gcp_10 770706.664 128731.741 4.733 woody field Control 

hab_13 770483.336 129120.095 9.792 forest by stream Error 

hab_23 770502.861 129236.441 10.883 forest edge Check 

hab_38 770729.599 128758.12 6.503 woody field Check 

hab_37 770767.545 128937.03 10.415 woddy Check 

hab_91 770726.818 128930.189 11.389 RU Check 
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14.2: Load Data 

1. Open global mapper and select Open data files 

 
 

2. Navigate to your project folder and select the point cloud file 
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3. Select Projection for LAZ data. State Plane NC 3200, NAD 83, and all in meters. Check 
for “Use Selected Projection for All Selected Files” If you are unsure about the 
coordinate system, you can find that information by opening the SiteName.text file 
from the Inertial Xplore.  
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4. Use a default setting 

 

5. Now you have loaded all Laz files 

 
6. Load the control.csv file: File -> Open data files -> control.csv 
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7. Generic ASCII Text File Import Options. Change coordinate layout depending on how 
your control.csv is formatted out. The first row in the file has the column titles. In this 
case, you would want to skip at start of file: 1. 

 
 

8. Assign the same coordinate system as LiDAR data. 
  



111 
 

9. Now you have loaded the point clouds and GCP data. But how do we know they are in 
the correct place? Let’s add a base-map. 

 
 

10. Go to File > Download Online Imagery/Topo/Terrain Maps. Select World Imagery. 
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11. Now we can assess if our data and GCPs are showing up in the located where we 
conducted our survey. But, our GCPs are very difficult to see, so let’s change their 
symbology so they are more visible. Double click on the GCP layer in the table of 
contents. Under the Point Style tab, click the radio button for Use Same Style for all 
Features, then click the Select Style button next to that. Choose a color that stands out 
from the drop-down and increase the scaling factor slightly. Click Ok then Apply then Ok 
again. 
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14.3: Merge LASs 
1. Merge all Laz files to create one point-cloud las. Select all in Control Center. 

 
 

2. Right click on it and go to Layer -> Export. Hit Ok. 

 
 

3. Export in LAZ file 
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4. Keep the default setting and hit OK. 

 
 

5. Then, name it as you like. 
6. Load the new Las into Global Mapper 
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14.4: Accuracy Assessment 
1. Click on LiDAR QC. 
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2. Set 0.5 meter for point cloud elevation calculation setup, and 50 as max pint cloud 
returns to consider per control point. 

 
 

3. Finally, you will get a result table. Export to CSV. The total RMSE for your unconstrained 
data is 0.445 m. 

 
 

4. You will repeat the tool for the constrained data later. 
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Section15: LiDAR PROCESSING STEP 3 – Scanlook PC LIDAR POINT 
CLOUD CONSTRAINING  
We are back on Scanlook again; this step be optional and is only required is the desired vertical 
accuracy of the point cloud is above 4cm. This guide will provide you with step-by-step 
instructions on constrain the point clouds with the GCPs to improve the total RMSE. 

15.1: Control.txt  
1. From your GCP points data, create a Text File of the point data. Go to your project folder and 

save this as a “control.txt” file. The picture below is an example of the format you will use. Save 
this in the main folder. Set this coordinate system as NCSPM3200 (meter). Save as Text (Tab 
Deliniated).  

 

 
2. Reload in your project in Point Cloud Export and click, “Control”. Then the “Control Point 

Analysis” screen will appear.  
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15.2: Control Point Analysis 

1. Set numbers like the image below. Click, “Make Points”. The process might take several minutes. 
These numbers are simply suggestions and may need to be modified to narrow or widen the 
search area for control point definition. 

 
 

2. The picture (Example) below will appear on your screen “Measure and Edit Control Points”. You 
are to find a target for each of point ID. Why do we have multiple gcp-4s? Because the lidar 
sensor detected the target twice on the way and back depending on where the target is located 
in a relashinship with the lidar. Statu “use” means it is used for the correction, but you can 
manually correct it too. Your goal here is to have as low of Residual X, Y as possible. 
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This example has the status of “failed” in red background which mean the algorithm with the 
parameters in the Control Point Analysis window could not find the GCPs.  Go back to the 
window and change the parameters in the Control Point Analysis window to find targets.  

 

 

 

 

 

 

3. Click on the “Green Arrow” this will open up the “Graphics” page and will allow you to view and 
correct your control points. Use the “measure” button when you wish to drop a red dot where 
you think it is the measured point. Or you can draw an X to mark. You can click, capital “L” on 
your keyboard then click and drag over the point that you are trying to measure, in the example 
below you can see the green lines that are drawn to make a correction to the control point 
measured. 

 

THIS IS AN EXAMPLE OF A POINT THAT WE CANNOT SEE IN THE CLOUD THEREFORE WE CANNOT 
USE IT.  
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4. The correction will show up, under Corr X Y. 

 
 

5. You can increase the size of the point by going to Edit -> Options. Change the “Lidar Point Size”. 

 
6. After the corrections have been made, click Compute and Apply. Then, exit this window. 
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7. In the Control Point Analysis, make sure the check marks “XY” and “Z” are checked. Hit “Apply” 
then exit the window. 
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15.3: Covert 
1. Come back to the main window and click “Convert” to generate the constrained LiDAR. 

Your constrained LAZs will be created in a file. 

 
 

2. Now you will go back to Section 15: Global Mapper to conduct the accuracy assessment 
again with check points.  
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Section 16: PROCESSING IN CloudCompare – LIDAR POINT CLOUD 
CLEANUP 
This guide will provide you with step-by-step instructions on operating CloudCompare which is a 
3D point cloud processing software. Once successfully completed, you will be able to clean up 
the erroneous points and create some visuals.  

16.1: Load Data 
1. Open CloudCompare. 
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2. Go to File -> Open to select the LiDAR file(.LAS/ LAZ). Make sure you will be able to see 
LAS cloud data. 

 
 

3. You can unselect some boxes for faster process 
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4. Loading takes a few moments as it is a huge data 

 
 

5. Data might be colorized by the safelight imagery. 

 
 

  



127 
 

16.2: Clean Points 
1. Change the angle of the point data so that you can see some erroneous points. Click on 

the Segment tool to segment them out. 

 
 

 
 

2. Zoom in and select erroneous point and segment out. 

 
 

3. Using a small segment tool window, you can segment out, stop or restart. 

 
 

4. When you are done removing them, lets save it. Now highlight the layer and save it as 
LAS data. File -> save. 
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5. Select ‘Original resolution’ then ‘OK.’ 
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16.3: Visuals 
1. Highlight the layer you would like to change colors. Edit -> Colors -> Height Ramp for 

changing color by elevation (z). Select blue for the first color and red for the second. 

 

 
 

2. Edit -> Colors -> Convert to Gray Scale 

 
3. Edit -> Colors -> Convert to Color Scale 

 
 

4. Change the display parameters to make it look good 
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Section 17: HOW TO MAKE DEMs & DSMs FROM LIDAR POINT 
CLOUDS  
DEM and DSM are in a raster format (2D not 3D) and they are used for many GIS applications. 
DEM, Digital Elevation Models, represent the bare-Earth surface, removing all natural and built 
features while DSM, Digital Surface Models, captures both the natural and built/artificial 
features of the environment. We made a full point cloud was created in the last section. Here 
we explain how to extract a ground level point cloud from the full point cloud and convert those 
clouds into a raster format. 

DSM: 

 

DEM: 
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17.1: DSM Generation in CloudCompare 
1. Load data 
Open CloudCompare and load the full point cloud (las) that you previously created. 

 

 
2. Cloth Simulation Filter 
The loaded data file will be filtered for ground points using the Cloth Simulation Filter (CSF) 
plugin here. The CSF extracts ground points from discrete return LiDAR point clouds and 
produces results with accuracies comparable to most state-of-the-art filtering algorithms. 
The separation of ground and non-ground points is essential in to the creation of an 
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accurate digital surface model (DSM). Select plugin -> CSF. For more information: 
https://www.cloudcompare.org/doc/wiki/index.php?title=CSF_(plugin)  

3. Parameters 
Two parameters: General parameter and Advanced parameter. The general parameter 
means that it must be set each time the program runs. The advance parameter means that 
it can be set according to the users need. 

General parameters- select one of the scenes (steep slope, relief, or flat) and uncheck the 
slope post processing for no steep slope 

Advanced parameters – 1m DEM, 500 iteration, 0.5 classification threshold (those numbers 
are suggestions.). 

Cloth resolution refers to the grid size (the unit is same as the unit of point clouds(m)) of 
cloth which is used to cover the terrain. The bigger cloth resolution you have set, the 
coarser DTM you will get.  

  

4. Save your DEM as las. Select the name of the layer and select file -> save. Make sure to 
save as LAS not LAZ if you wish to process LiDAR data in ArcGIS later. 

https://www.cloudcompare.org/doc/wiki/index.php?title=CSF_(plugin)
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17.2: Load and Find Pixel Size 
Here you will use ArcGIS Pro to convert the LiDAR data (3D) to raster format (2D).  

1. Open ArcGIS Pro and Load 
Open your ArcGIS Pro project and load your DEM and DSM las. 

2. Calculate cell size for output raster data 
The level of detail (features/phenomena) represented by a raster is often dependent on the 
cell (pixel) size, or spatial resolution, of the raster. The cell must be small enough to capture 
the required detail, but large enough so computer storage and analysis can be performed 
efficiently. For more info: https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-
and-images/cell-size-of-raster-data.htm  

Point File Information tool –This tool calculates the average of point spacing. This point 
spacing number will be used to calculate the appropriate the spatial resolution of raster 
output. 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/cell-size-of-raster-data.htm
https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/cell-size-of-raster-data.htm
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Load your DEM.las data to find out the point spacing. Make sure to check the checkbox next 
to “Improve LAS files point spacing estimate.”. A shapefile will be created as an output. 
Open the output table to find the point spacing. You might think the average point spacing is 
a good cell size for the output raster, but this typically results in too many empty, or NoData, 
cells because lidar points are not evenly spaced. A reasonable size is four times the point 
spacing.  For more information about rasterization cell size: 
https://desktop.arcgis.com/en/arcmap/10.3/manage-data/las-dataset/lidar-solutions-
assessing-lidar-coverage-and-sample-density.htm  

For example:  

Pt spacing: 0.07287134 m 
Raster resolution: 0.3 m2 (0.07287134x 4) 
 

3. LAS Dataset to Raster 
Use a “LAS Dataset To Raster” tool. Load your DEM.las data and put the calculated raster 

resolution for cell size sampling values. You can save the TIF file in a regular folder not the 
geodatabase. 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/las-dataset/lidar-solutions-assessing-lidar-coverage-and-sample-density.htm
https://desktop.arcgis.com/en/arcmap/10.3/manage-data/las-dataset/lidar-solutions-assessing-lidar-coverage-and-sample-density.htm
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Repeat the same steps for full point cloud. Make this with the same spatial resolution since we 
are doing pixel-based classification.  
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Section 18: HOW TO PREPARE VARIABLES FOR CLASSIFICATION 
MODELS 
To make a wetland classification map, we will create a classification model through machine 
learning algorithms. In machine learning, classification refers to a predictive modeling problem 
where a class label (wetland class here) is predicted for a given example of input data. 
Therefore, the machine learns how to classify based on the sample dataset given. In this 
manual, the classification models are made from LiDAR, multispectral, and habitat data through 
random forest classification. Here we explain the predictor variables. The response variable 
(wetland class data) is the cause. Its value is independent of other variables in your study. The 
predictor variable (UAS data) is the effect. Its value depends on changes in the independent 
variable. 

Learn more about RF here: (https://www.youtube.com/watch?v=J4Wdy0Wc_xQ&t=187s). 

Predictors: LiDAR data (LAS data) is a point cloud of elevation data, which will be used to create 
ten topographic layers.: 

1. Digital Surface Model (DSM) 
2. Digital Elevation Model (DEM) 
3. Canopy Height Model (CHM) 
4. Smoothed DEM (sDEM) 
5. Hydro-condition DEM (hDEM) 
6. Aspect 
7. Slope 
8. Curvature 
9. Plan Curvature 
10. Profile Curvature 

Predictors: Multispectral imagery (green, red, red-edge, and near-infrared) (TIF data) is 
collected in the field. Three vegetation indices are created from this dataset.  

1. Normalized Difference Vegetation Index (NDVI) 
2. Normalized Difference Red Edge Index (NDRE) 
3. Normalized Difference Water Index (NDWI) 

Response: Habitat sample data that were collected in the field using on screen analysis are used 
to train and verify the wetland model, which is called a response variable. The figure below 
indicates the workflow of data processing.  

The workflow below shows the overall steps of how to create a wetland classification model.   
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18.1: Variables made by LiDAR Data 
In the previous section, we have already made raster DEM and DSM. Here additional eight raster 
layers will be generated from the DEM using ArcGIS Pro. Make sure to set up the tool in the 
environments tab so that the output raster is snapped to either DEM or DSM. 

 

1. Digital Surface Model (DSM) 
2. Digital Elevation Model (DEM) 
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3. Canopy Height Model (CHM) 
DSM - DEM 

 
4. Smoothed DEM (sDEM) 

 
5. Hydro-condition DEM (hDEM) 

 
6. Aspect 
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7. Slope 

 
8. Curvature 
9. Plan Curvature 
10. Profile Curvature 
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Model builder in ArcGIS Pro is a very useful way to keep all the settings and everything 
organized. 
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18.2: Variables made by Multispectral Data 
Those The vegetation indices can be calculated using multispectral layers and it can be done in 
ArcGIS or any other software that you may have.   

1. Normalized Difference Vegetation Index (NDVI) 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 =  
(𝑁𝑁𝑁𝑁𝑁𝑁 − 𝑁𝑁𝑅𝑅𝑅𝑅)
(𝑁𝑁𝑁𝑁𝑁𝑁 + 𝑁𝑁𝑅𝑅𝑅𝑅)

 

2. Normalized Difference Red Edge Index (NDRE) 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 =  
(𝑁𝑁𝑁𝑁𝑁𝑁 − 𝑁𝑁𝑅𝑅𝑅𝑅 𝑁𝑁𝑅𝑅𝐸𝐸𝑅𝑅)
(𝑁𝑁𝑁𝑁𝑁𝑁 + 𝑁𝑁𝑅𝑅𝑅𝑅 𝑁𝑁𝑅𝑅𝐸𝐸𝑅𝑅)

 

 
3. Normalized Difference Water Index (NDWI) 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 =  
(𝐺𝐺𝐺𝐺𝑅𝑅𝑅𝑅𝐺𝐺 − 𝑁𝑁𝑁𝑁𝑁𝑁)
(𝐺𝐺𝐺𝐺𝑅𝑅𝑅𝑅𝐺𝐺 + 𝑁𝑁𝑁𝑁𝑁𝑁)

 

 

18.3: Variables made by Habitat Data 
1. Open the habitat point data in ArcGIS. If the class name contains …UB (unconsolidated 

bottom) or … US (unconsolidated shore), the classes are not wetland but water. If you 
see more than one of them, make sure to combine those US/UB classes together into 
one class and name it as water. 
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2. Since the habitat data is still in vector format, you will need to convert it into a raster 
format by using a “Point to Raster” tool. Make sure to set the cell size and snap the aster 
to one of the topo raster layers that you have made in the previous section. Save the 
data as tif file. 
 

 
 

18.4: Making a Raster Stack 
1. Now you have prepared all the layers. Topo layers (10) + vegetation index (3) + Habitat 

data (1) = 14. Here you are going to stack all the raster layers into one single tif file, 
which is also called multi-dimensional raster. 

2. Go to Imagery -> Raster Functions. Then, a Raster Functions window will pop up. 
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3. Search and click on “Composite Bands.”. 

 
4. Select all the tif layers. Once you combine them, you will not be able to see the band 

names anymore. Therefore, make sure to remember the order of layers you input. 

  

1 Habitat 
2 DEM 
3 sDEM 
4 hDEM 
5 DSM 
6 CHM 
7 Aspect 
8 Slope 
9 Curvature 
10 PlanCurv 
11 ProfileCurv 
12 NDVI 
13 NDRE 
14 NDWI 
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5. Then, the composite Bands will be created. 

 
6. Check if the AOI is within all the raster layers. If not, adjust the AOI to fit it. For example, 

the AOI (red rectangle) below is too big to fit both topo and vegetation index layers, so 
you can make it a little smaller. 
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7. Now clip this Composite Band with the AOI to remove unnecessary areas.  
For NoDataValue, empty here the when you process. 
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8. Stack raster clipped to AOI is created. Now turn on and show the habitat points and 
stack raster on the map. The stack raster has habitat data, but the wetland classes of the 
habitat data is stored in numbers instead of text. Comparing the habitat points with the 
stack raster’s habitat data and find which number coincides with which habitat name. 

 
For example, if you click on the brown raster pixel of stack raster, that shows as 2, which 
is NonWet_Open.  
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Section 19: RANDOM FOREST ANALYSIS 
With a stack raster is created, from here, we are going to use R programming language to run a 
random forest classification. RStudio (https://www.rstudio.com/), a programing platform, is 
used throughout this guide. 

19.1: Raster to Data frame 
We are going to convert the raster layers into data frame, which is the most common dataset 
format used in R. Open the “RasterToDataFrame.R” file in RStudio. 

1. Create an empty file and bring the “RasterToDataFrame.R” and the raster stack that you 
prepared in the previous section. 

 
2. Open the RasterToDataFrame.R in RStudio and run the “1. setting environment” section 

first. Make sure you change the work directory at line 27 (setwd) to the folder you just 
made before you run it. 

 
  

https://www.rstudio.com/
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3. Run the “2. Load and name” section. Make sure you change the name of the tif file (line 
34) exactly as it is saved. 

 
 
When you run the line 42, all the raster layers will be plotted in the plot window. 
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4. Run the “3. Convert the raster into DataFrame” section.  
For this site, about ninety habitat points were created from made out of all the areas of 
pixel. df_hab is the dataset that only covers the areas of pixels where habitat points 
were collected. because When you train a model you don’t need a dataset that does not 
have response data. 
df_all is a dataset including all the areas of data, which will be used to predict wetland 
classes based on the predictors. 

 
5. Save the dataframe as RDS dataset. 

 
 

19.2: Random Forest Classification using H2O package 
1. Create a folder and put those files below. 

• Wetland_RF_H2O.R 
• SiteName_all.rds 
• SiteName_hab.rds 
• SiteName_Stack.tif 

 
2. Open the “Wetland_RF_H2O.R” and run the “1. Setting environment” section. You only 

install packages once in your computer but run library every time you run. 

 
3. Run the “2. Load RDS data” section. Make sure to change the path to the folder (fn <- 

folder path) and change the name of the RDS file. 
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4. Here we use H2O package to run random forest analysis. Here I would recommend 
running by each block to make sure it runs correctly. Make sure to run line 25 – 27 every 
time when you get an error of running out of computer memory. 

 
 
When you run rforest.model at line 49 (copy and paste the results as it will be used for 
post analysis). Below is an example of results:  this is what you get for example: 
Model Details: 
============== 
 
H2OMultinomialModel: drf 
Model ID:  DRF_model_R_1641325516784_1 …….. 
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5. Run the “4. Save model as file” section. Change the names of the files (line 68 and 69) as 
accordingly. When you save the model, it will be saved as the model ID in the folder. In 
this example, the model is saved as “DRF_model_R_1641325516784_1” 
When you run line 72 and 73 (copy and paste the results if you want to make the 
variable importance plot later), you can see the variable importance. 
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6. Next step is to use the random forest model that was created in the previous section, 
and predict wetland classification for the whole area. Make sure to change the name of 
the file (line 80) accordingly. Also, line 89-91 can tell you how long the model took to 
train and predict. 

 
7. Run the section 5 to save the x, y, and prediction results for the model result data. Make 

sure you change the names of the file you will save (line 99 and 100) as you like. 
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19.3: Export Results as Raster 
1. Section 6 is to create the raster data that shows the model prediction of wetland class 

and export it. 
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Section 20: DATA POST ANALYSIS 
This section explains how to do the post processing, which is consists of the calculation of model 
performance matrices, making prediction maps, and making variable importance plots. 

20.1: Calculating Model Performance Matrices 
Assume you have copied and pasted the model result (line 49) and there you can find a 
classification matrix, and this is what it looks like. Here we show how to calculate the overall 
accuracies, producer and user’s accuracy, sensitivity, specificity, and finally kappa coefficient. 

 

1. Overall accuracies 
(31 + 24 + 30)/ 108 = 0.7870 
          ≒ 78.7% 

 
2. Producer’s accuracy (1: PFO) = sensitivity 

31 ÷ 42 = 0.738 
 ≒ 74 % 

 
3. User’s accuracy (1: PFO) 

31 ÷ 42 = 0.738 
   ≒ 76 %  

 
 

4. Sensitivity = producer’s accuracy 

Classification Model
1: PFO 2: NonWet_3: PSS

Reference 1: PFO 31 3 8
2: NonWet_Open 3 24 1
3: PSS 7 1 30

Classification Model
1: PFO 2: NonWet_3: PSS total

Reference 1: PFO 31 3 8 42
2: NonWet_Open 3 24 1 28
3: PSS 7 1 30 38
Total 41 28 39 108

Classification Model
1: PFO 2: NonWet_3: PSS total Producers

Reference 1: PFO 31 3 8 42 0.74
2: NonWet_Open 3 24 1 28 0.86
3: PSS 7 1 30 38 0.79

Classification Model
1: PFO 2: NonWet_3: PSS total Producers

Reference 1: PFO 31 3 8 42 0.74
2: NonWet_Open 3 24 1 28 0.86
3: PSS 7 1 30 38 0.79
Total 41 28 39 108
Users Accuracy 0.756 0.857 0.769
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5. Specificity (1: PFO) 
(24 + 1 + 1+ 30) ÷ (24 + 1 + 1+ 30 + 3 +7) = 56 ÷ 66 
     = 0. 84848 

≒ 84.85 % 

 
6. Kappa coefficient 

Pre(a) = ( 31 + 24 + 30 )  ÷ 108 
            = 0.7870 
Pre(e) =  (0.38*0.39)+(0.25*0.25)+(0.36*0.35) 
            = 0.14782 + 0.067081 + 0.127072 
            =  0.341973 
K = (pr(a) - Pr(e) )/ (1-Pr(e)) 
   =(0.7870 - 0.341973) ÷ (1 - 0.341973) 
   = 0.445027 ÷ 0.658027 
   = 0.6763 
   ≒ 67.63 % 

 
 

Classification Model
1: PFO 2: NonWet_3: PSS total Producers sensitivity specificity

Reference 1: PFO 31 3 8 42 0.7381 0.7381 0.8485
2: NonWet_Open 3 24 1 28 0.8571 0.8571 0.9500
3: PSS 7 1 30 38 0.7895 0.7895 0.8714
Total 41 28 39 108
Users Accuracy 0.756 0.857 0.769

Classification Model
1: PFO 2: NonWet_3: PSS total Producers sensitivity specificity true/total

Reference 1: PFO 31 3 8 42 0.7381 0.7381 0.8485 0.389
2: NonWet_Open 3 24 1 28 0.8571 0.8571 0.9500 0.259
3: PSS 7 1 30 38 0.7895 0.7895 0.8714 0.352
Total 41 28 39 108
Users Accuracy 0.756 0.857 0.769
true/total 0.380 0.259 0.361

k=(pr(a) - Pr(e) )/ (1-Pr(e))
Pr(a) 0.787037
Pr(e) 0.34
k 0.676394

Pr(e) = (0.38*0.39)+(0.29*0.25)+(0.36*0.35)
Pr(a) =(true+true)/total
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Classification Model
1: PFO 2: NonWet_3: PSS total true/total Producers sensitivity specificity

Reference 1: PFO 31 3 8 42 0.39 73.81% 0.738095 0.848485
2: NonWet_Open 3 24 1 28 0.26 85.71% 0.857143 0.95
3: PSS 7 1 30 38 0.35 78.95% 0.789474 0.871429
Total 41 28 39 108
true/total 0.380 0.259 0.361
Users Accuracy 75.61% 85.71% 76.92% accuracy 0.787037

k=(pr(a) - Pr(e) )/ (1-Pr(e))
Pr(a) 0.787037
Pr(e) 0.34
k 0.676394

Pr(a) =(true+true)/total
Pr(e) = (0.31*0.35)+(0.68*0.64)
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20.2: Making Prediction Map 
 Now that you have created and exported the final result map in raster format, you can visualize 
this in ArcGIS Pro. Simply load the TIF file and classify the map by wetland class.  
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20.3: Making Variable Importance Plots 
When you run line 72, you will get a result table of variable importance plot. You can make this 
into a bar plot graph using Excel for example.  

Variable Importances:       

 variable relative_importance scaled_importance percentage 
1 NDVI 3934.388672 1 0.151746 
2 Smooth DEM 3196.75708 0.812517 0.123297 
3 NDWI 3067.769531 0.779732 0.118322 
4 Slope 2700.459229 0.686373 0.104155 
5 DEM 2525.5 0.641904 0.097407 
6 CHM 2208.754883 0.561397 0.08519 
7 Hydro DEM 2186.508545 0.555743 0.084332 
8 DSM 1814.694214 0.461239 0.069991 
9 Aspect 1124.103271 0.285712 0.043356 

10 
Plan 
Curvature 994.933533 0.252881 0.038374 

11 NDRE 893.176453 0.227018 0.034449 

12 
Profile 
Curvature 660.776001 0.167949 0.025486 

13 Curvature 619.562866 0.157474 0.023896 
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APPENDIX C: EXAMPLE METDATA TABLE  

In creating metadata, each final feature class for each respective study area was given 

detailed metadata based on how the data was acquired and what purpose each layer 

served in the project before being copied into the final geodatabases. These feature 

classes consisted of layers involved in mission planning, field work, and post-fieldwork 

lab methods. Each feature class metadata report contained a title, purpose, abstract, 

credits, use limitations (if applicable), extent, and scale range.  A template was created to 

fill metadata for each feature class in each site. Each study site’s NWI, County NAIP, and 

County CREWS layers had existing original metadata, which was kept as it was found. 

Metadata files were created for all the other layers across each study site. A description of 

each feature class and a list of component fields for the Carolina Bays study area is 

shown in table below, for illustrative purposes. 

Table AC 1. Table displaying metadata for the Carolina Bays study area. The field 
mission was conducted on February 23rd, 2021. 

Feature Class Description Fields 
Carolina_Bays_AOI Area of interest polygon created for 

the Carolina Bays study site. Field 
operations and data collection are 
conducted within this area of interest.  
AOIs are selected from locations 
containing multiple National Wetland 
Inventory (NWI) wetland types. 

OBJECTID, Shape, 
SHAPE_Leng, 
Area, 
Shape_Length, 
Shape_Area 

Carolina_Bays_FP_Pla
n 

Planned flight path created for drone 
flights and imagery collection over the 
Carolina Bays study site. 

OBJECTID, Shape, 
Id, Shape_Length 

Carolina_Bays_FP_Col
lected 

Flight path taken and recorded by 
drone flights over the Carolina Bays 
study site for imagery collection. 

OID, Shape, Name, 
FolderPath, 
SymbolID, 
AltMode, Base, 
Clamped, 
Extruded, Snippet, 
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Popupinfo, 
ShapeLength 

Carolina_Bays_GCP_P
lan 

Ground control points created and 
placed as evenly as possible across the 
area of interest and intended to be 
beneath the flight path of the drones as 
they collect imagery of the study area. 
Ground control points will be used to 
constrain the imagery collected. 

OBJECTID, Shape, 
Id, POINT_X, 
POINT_Y 

Carolina_Bays_GCP_C
ollected 

The locations of all ground control 
points created and placed around the 
area of interest were recorded during 
the field mission. Ground control 
points will be used to constrain the 
imagery collected. 

OBJECTID, 
PointName, x, y, z, 
habitat, trimble, 
observed_topo, 
Shape, 
LiDAR_Use 

Carolina_Bays_Habpts
_Plan 

Randomly generated 15 habitat points 
created using a spatially balanced 
approach for accessibility for each 
NWI wetland type and 50 habitat 
points placed in non-wetland areas 
across the study site. 

OBJECTID_12_13
, Shape, 
ATTRIBUTE, 
POINT_X, 
POINT_Y 

Carolina_Bays_Habpts
_Final 

Habitat points collected in the field in 
addition to the planned habitat points 
placed across the Carolina Bays study 
site. Each point was examined using 
imagery from various sources, 
including Google Earth, Google Maps, 
North Carolina OneMap, and the 
National Agriculture Imagery Program 
(NAIP) to determine whether the point 
matched its previous NWI habitat type 
designation, and to update the point if 
it did not match its previously given 
habitat type. Confidence levels were 
then assigned to each point’s full NWI 
habitat code as well as to each point’s 
NWI habitat code shortened to contain 
the habitat’s main system, subsytem, 
and class levels. 

OBJECTID_12_13
, Shape, 
OBJECTID_12, 
ATTRIBUTE, 
POINT_X, 
POINT_Y, 
Hab_actual, 
Confidence, 
Hab_actual_2, 
Confidence_2 

Carolina_Bays_NWI This data set represents the extent, 
approximate location and type of 
wetlands and deepwater habitats in the 
United States and its Territories. These 

FID, Shape, 
ATTRIBUTE, 
AreaHEC, 
AreaAcres, AreaM, 



165 
 

data delineate the areal extent of 
wetlands and surface waters as defined 
by Cowardin et al. (1979) to provide 
current geospatially referenced 
information on the status, extent, 
characteristics and functions of 
wetlands, riparian, deepwater and 
related aquatic habitats. 

Shape_Length, 
Shape_Area 

Brun_naip This data set contains imagery from 
the National Agriculture Imagery 
Program (NAIP). The NAIP acquires 
digital ortho imagery during the 
agricultural growing seasons in the 
continental U.S. This file was 
generated by compressing NAIP 
imagery that cover the county extent. 
The NAIP imagery is generally 
acquired in projects covering full 
states in cooperation with state 
government and other federal agencies 
who use the imagery for a variety of 
purposes including land use planning 
and natural resource assessment. The 
NAIP is also used for disaster response 
often providing the most current pre-
event imagery.   

OBJECTID, Shape, 
IDATE, SDATE, 
EDATE, BCON, 
CAM_TYPE, 
CAM_MAN, 
HARD_FIRM, 
SENSNUM, 
AC_TYPE, 
ACTAILNUM, 
RED_RNGE, 
GREEN_RNGE, 
BLUE_RNGE, 
NIR_RNGE, 
Shape_Length, 
Shape_Area 

Brun_crews The North Carolina Coastal Region 
Evaluation of Wetland Significance or 
NC-CREWS. NC-CREWS functions 
in a hierarchical manner, analyzing 
three primary wetland functions 
(Hydrology, Water Quality and 
Wildlife Habitat), seven wetland 
subfunctions and 39 landscape and 
wetland parameters.  Wetlands are 
assigned ratings of Beneficial 
Significance, Substantial Significance 
or Exceptional Significance, 
depending on how well they perform 
the various wetland functions. 

OBJECTID, Shape, 
AREA, 
PERIMETER, 
BRUN_WETS_, 
BRUN_WETS1, 
W_TYPE, HGM, 
WET_NAME, 
Shape_Length, 
Shape_Area 
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